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PENYAMPAIAN KONTRAK KELAS 

 

 
1. Kehadiran mahasiswa diharapkan tepat waktu di ruang lab editing, 

keterlambatan diberikan toleransi 30 menit dari jadwal masuk kelas. 

 

2. Mahasiswa tidak diperkenan menggenakan kaos oblong, sandal jepit, 

merokok, makan dan minum didalam kelas dan membawa minuman keras. 

 

3. Bersama-sama menghargai proses perkuliahan dan menjaga kelancaran 

perkuliahan.  

 

4. Sistem tugas dibedakan atas dua, yaitu: 

a. Tugas Individu 

b. Tugas Kelompok 

 

Keduanya dikumpulkan tepat waktu. Keterlambatan mengumpulan tugas 

akan mengurangi nilai dan ditoleransi hingga UTS (untuk tugas pribadi) dan 

hingga UAS (untuk tugas kelompok).  

 

 

 

KOMPETENSI PENILAIAN 

 

NO Aspek Penilaian Prosentase 

1 Kehadiran 10 % 

2 Tugas 20 % 

3 UTS 30 % 

4 UAS 40 % 

TOTAL 100 % 
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BAB 1. SEKILAS TENTANG 

PROSES PRODUKSI VIDEO 
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Saat ini kita asumsikan kalau kita telah memiliki sebuah judul cerita, misalnya 

“Pernikahan Wishnu dan Ema”, “Profil Perusahaan Jamu Cap Kapak Maut”, atau 

“Petualangan Besar MatMitMut : Tentang Neraka Jahanam”, atau kita membuat sebuah 

video pendek untuk konsumsi Web, kepentingan industri atau presentasi pelatihan, iklan 

televisi, feature film, atau hanya sebuah proyek pribadi, maka semua proses yang 

dilakukan diatas sebenarnya memiliki kesamaan. Gambar 1.8 menggambarkan tahapan- 

tahapan dalam proses produksi digital video secara umum, dengan adanya gambaran 

tersebut maka akan menjadi jelas letak dan fungsi pekerjaan video editing dalam proses 

produksi digital video. Apabila kita melihat bagan alir proses produksi digital video 

tersebut, maka suatu waktu terlihat bahwa ada tahapan yang overlap, proses produksi 

digital video sebenarnya tidak harus sama seperti bagan alir tersebut, tetapi kita dapat 

mengadaptasikan rangkaian kerja tersebut sesuai dengan kebiasaan, ataupun gaya kerja 

kita, karena setiap orang pasti memiliki gaya kerja yang berbeda-beda. 
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Gambar 1.1 Bagan Alir Proses Kreatif Produksi Digital Video 

 

 
 

 

 

Preproduction/Praproduksi 

Preproduction atau Pra Produksi merupakan tahapan perencanaan. Secara umum 

merupakan tahapan persiapan sebelum memulai proses produksi (shooting film atau 

video). Dengan lahirnya teknologi digital video dan metode nonlinear editing maka 

proses produksi video menjadi lebih mudah. Ketika kita akan memulai sebuah proyek, 

terkadang kita telah memiliki stock-shoot/footage video yang kita butuhkan, untuk itu 

kita harus melakukan peninjauan ulang segala kebutuhan sesuai dengan cerita yang akan 
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kita buat. Artinya, kita harus mempersiapkan footage video yang telah ada, fotografi, 

diagram dan grafik, gambar ilustrasi, atau animasinya. Tetapi banyak pula para 

videographer yang memulai dari awal atau dari nol. Pada intinya tujuan pra produksi 

adalah mempersiapkan segala sesuatunya agar proses produksi dapat berjalan sesuai 

konsep dan menghasilkan suatu karya digital video sesuai dengan harapan. 

 Outline 

 

Untuk mempermudah membuat proyek video, maka kita harus membuat sebuah rencana 

kasar sebagai dasar pelaksanaan. Outline dijabarkan dengan membuat point-point 

pekerjaan yang berfungsi membantu kita mengidentifikasi material apa saja yang harus 

dibuat, didapatkan, atau disusun supaya pekerjaan kita dapat berjalan. Outline dapat 

disusun dengan rekan kerja atau dengan klien kita, supaya kita dapat menghasilkan 

sebuah visi dan persepsi yang sama tentang langkah pelaksanaan proyek yang akan 

dibuat. 

 Script/Skenario 

 

Dengan menggunakan outline saja sebenarnya sudah cukup untuk memulai tahapan 

pelaksanaan produksi, tetapi dalam berbagai model proyek video, seperti iklan televisi, 

company profile, sinetron, drama televisi, film cerita dan film animasi tetap 

membutuhkan skenario formal yang berisi dialog, narasi, catatan tentang setting lokasi, 

action, lighting, sudut dan pergerakan kamera, sound atmosfir, dan lain sebagainya. 

 Storyboard 

 

Apabila kurang cukup dengan outline dan scenario, maka kita dapat pula menyertakan 

storyboard dalam rangkaian perencanaan proses produksi kita. Storyboard merupakan 

coretan gambar/sketsa seperti gambar komik yang menggambarkan kejadian dalam film. 

Di dalam gambar tersebut juga berisi catatan mengenai adegan, sound, sudut dan 

pergerakan kamera, dan lain sebagainya. Penggunaan storyboard jelas akan 

mempermudah pelaksanaan dalam proses produksi nantinya. 



Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 
 
 

 Rencana Anggaran Biaya 

 

Ketika kita sedang mengerjakan proyek professional ataupun pribadi, maka sangat 

dianjurkan untuk merencanakan anggaran biaya produksi. Dalam proyek professional, 

rencana anggaran biaya berguna untuk mengamankan keuangan perusahaan. Tanpa 

anggaran biaya yang terencana, dan hanya mengandalkan spekulasi, maka prosentase 

kerugian akan menjadi besar. Rencana anggaran biaya meliputi gaji untuk kita, rekan 

kerja, actor dan talent lainnya (effect specialist, graphics designer, musisi, narrator, dan 

animal trainers), begitu pula dengan pembelian kaset DV, biaya sewa lokasi, kostum, 

properties, sewa peralatan, catering dan yang lainnya. 

 

Production/Produksi 

“Quiet on the set! Action! and Roll ’em!”, kata-kata tersebut seringkali terdengar saat 

shooting berlangsung, pada intinya merekam kejadian langsung, adegan animasi dan 

suara pada film, videotape atau DV untuk menghasilkan footage/clip disebut dengan 

“production” atau proses produksi. Selama proses produksi berlangsung, perhatian kita 

akan tertuju pada lighting/pencahayaan, blocking (dimana dan bagaimana aktor atau 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 1.2 Contoh storyboard 
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subyek kita bergerak), dan shooting (bagaimana pergerakan kamera dan dari sudut mana 

scene kita dilihat). Ada banyak referensi yang bagus untuk mempelajari lebih dalam 

mengenai proses produksi. Pembuatan animasi/motion graphics dapat pula dikategorikan 

dalam proses produksi, karena bertujuan menghasilkan footage yang nantinya akan 

disusun dan diedit dalam proses pasca produksi. 

 

Post Production/Paska Produksi 

Setelah proses produksi maka akan dihasilkan footage atau koleksi klip video. Untuk 

membangun dan menyampaikan cerita, maka harus mengedit dan menyusun klip-klip 

tersebut dan tentu saja menambahkan visual effects, gambar, title dan soundtrack. Proses 

diatas disebut dengan postproduction atau pasca produksi. Berikut ini merupakan aplikasi 

dari Adobe yang khusus dirancang untuk proses pasca produksi : 

 Adobe Premiere Pro, aplikasi editing yang real‐time untuk para professional dalam bidang digital 

video production. 

 Adobe After Effect, sebuah aplikasi khusus untuk Motion Graphics dan Visual Effect. 

 

 Adobe Audition™, aplikasi professional untuk pengolahan audio digital. 

 

 Adobe Encore™ DVD, aplikasi professional untuk DVD authoring. 

 

Selain aplikasi-aplikasi diatas, dikenal pula dua aplikasi grafis professional yang juga 

memainkan peranan penting dalam menghasilkan elemen grafis berkualitas tinggi, 

aplikasi tersebut adalah Adobe Photoshop® dan Adobe Illustrator®. Pada bab lain 

akan dibahas pula metode integrasi berbagai produk Adobe untuk keperluan pasca 

produksi. 
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BAB 2 

 PENGENALAN ADOBE 

PREMIERE PRO 
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Adobe Premiere Pro dibuat oleh Adobe System Inc, yang merupakan versi pembaharuan 

dari beberapa versi Adobe Premiere terdahulu. Adobe Premiere Pro mulai di luncurkan 

ke pasaran pada bulan Agustus tahun 2003. Mulai versi 6.0 Adobe Premiere dapat 

digunakan untuk mengedit file video dengan format DV. Adobe Premiere telah menjadi 

program standar bagi para profesional dalam bidang digital video. 

 

Fitur Baru Adobe Premiere Pro 

Pada versi baru ini Adobe Premiere Pro hadir dengan tampilan baru, tetapi lebih simple 

dari para pendahulunya. Penamaan efek video serta transisinya sedikit mengalami 

perubahan sehingga membutuhkan waktu bagi para pengguna versi lama (6.0 dan 6.5) 

untuk menyesuaikan diri dalam tampilan yang baru ini. Beberapa fasilitas baru yang ada 

dalam Adobe Premiere Pro adalah : 

 Real Time Rendering, dengan fasilitas ini memungkinkan melihat hasil transisi tanpa melalui 

proses render. 

 Adobe Product Integration, yaitu kita dapat menggunakan berbagai produk Adobe (Adobe 

Photoshop, Adobe After Effects, Adobe Encore DVD dan Adobe Audition) untuk bekerja sama 

dengan Adobe Premiere Pro. 

 Audio Mixer, pada versi ini Adobe telah memperbarui fasilitas audio mixernya, yang mendukung 

track‐based effects, submix tracks, mendukung proses perekaman voiceover langsung (dubbing), 

fasilitas panning untuk sorround dan stereo dan VST filter. 

 Color Correction, Adobe Premiere Pro mulai versi ini melengkapi dirinya dengan fasilitas eksklusif 

ini. Fasilitas ini biasanya terdapat pada software editing standar broadcast (high‐end). Dengan 

adanya fasilitas ini kita dapat dengan mudah mengkoreksi warna clip video kita sesuai dengan 

keinginan. 

 Motion Path, pada versi yang baru ini Adobe Premiere Pro menerapkan prinsip keyframing untuk 

animasi perpindahan posisi pada klip‐klip nya. 

 Visual Effect yang dilengkapi dengan keyframe, sehingga dapat dianimasikan dengan mudah. 
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 Fasilitas export dalam berbagai format, Adobe Premiere Pro menyediakan fasilitas ekspor kedalam 

berbagai format media seperti MPEG‐1, MPEG‐2, Microsoft DV, AVI dalam berbagai kompresi, 

Windows Media 9 Series dan Real Media 9. 

 

Kebutuhan Komputer untuk Menjalankan Adobe 

Premiere Pro 

PC (Personal Computer) digunakan untuk mengolah file video baik proses capture 

maupun editing menggunakan software Adobe Premiere Pro. PC yang akan digunakan 

minimal harus memiliki spesifikasi sebagai berikut : 

 Processor Intel® Pentium® III – 800 Mhz 

 

 RAM 256 Mb 

 

 Harddisk berkecepatan 7200 rpm dengan kapasitas besar (space kosong minimal 20 Gb) 

 

 VGA Card 32 Mb (resolusi monitor 1024x768 pixel) 

 

 Sound Card yang mendukung DirectX 

 

 CD‐ROM/RW dan DVD‐ROM/RW untuk menulis dalam format VCD maupun DVD 

 

 DV Capture Card/IEEE 1394 Card 

 

 Sistem Operasi Windows XP Home/Pro Edition 

 

Untuk menggunakan Adobe Premiere Pro maka harus menggunakan Microsoft Windows 

XP sebagai sistem operasinya. Hal ini dikarenakan Adobe Premiere Pro hanya dapat 

berjalan pada sistem operasi tersebut. Lain dengan Adobe Premiere versi 6.5 yang masih 

dapat berjalan pada sistem operasi Windows 98SE dan Windows2000. 

 

Instalasi Adobe Premiere Pro 

Setelah mempersiapkan seluruh perangkat keras (hardware) yang dibutuhkan maka yang 

harus dilakukan kemudian adalah menginstal software Adobe Premiere Pro ke dalam 

komputer. Berikut ini langkah-langkah instalasi program Adobe Premiere Pro : 

1. Masukkan CD Installer Adobe Premiere Pro ke dalam drive CD‐ROM, maka akan tampil kotak 

dialog seperti di bawah ini. 
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Gambar 2.2 Kotak Dialog End User License Agreement 

 

 
 

 

2. Pilih bahasa yang akan digunakan dalam proses instalasi, pada pilihan Select the Language 

biarkan pilihan pada US English, kemudian tekan tombol OK. 

 

3. Kotak dialog End User License Agreement akan ditampilkan. Klik tombol Accept untuk 

melanjutkan proses instalasi. 

4. Setelah itu akan muncul kotak dialog pilihan instalasi. Klik pilihan Install Adobe Premiere Pro 

untuk mengistalasi Adobe Premiere Pro. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 2.1 Tampilan Awal Instalasi dengan pilihan bahasa 
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Gambar 2.4 Kotak Dialog Adobe Premiere Pro Setup 

 

 
 

 

5. Selanjutnya akan tampil kotak dialog Adobe Premiere Pro Setup, kotak dialog ini 

menginformasikan bahwa Adobe Premiere Pro akan diinstalasikan. Klik Tombol Next. 

6. Setelah itu akan tampil kotak dialog Select Language. Pilih bahasa US English yang akan 

digunakan pada proses instalasi, kemudian klik tombol Next untuk melanjutkan. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 2.3   Pilihan instalasi software 
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Gambar 2.6 Kotak Dialog Software License Agreement 

 

 
 

 

7. Selanjutnya akan tampil kotak dialog Software License Agreement. Klik tombol Yes. 
 

8. Kotak dialog User Information akan ditampilkan. Isi informasi Title/Salutation, First Name, 

Last(Family) Name, Company, dan Serial Number. Setelah terisi semua, klik tombol Next 

untuk melanjutkan. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2.5  Kotak Dialog Select Language 
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Gambar 2.8 Kotak Dialog Choose Destination Location 

 

 
 

 

9. Kemudian akan tampil kotak dialog Choose Destination Location. Pilih tempat instalasi untuk 

file Adobe Premiere Pro. Klik tombol Browse untuk memilih tempat instalasi. Apabila setuju 

dengan tempat penyimpanan default, maka dapat langsung diklik tombol Next untuk 

melanjutkan proses instalasi. 

10. Setelah itu akan tampil kotak dialog Start Copying Files. Kotak dialog ini menginformasikan 

bahwa program akan memulai mengkopi file‐file ke dalam lokasi penyimpanan yang telah 

ditentukan. Kemudian klik Next untuk melanjutkan. 

 

 

 

 

 

 

 

 

 

 

 
Gambar 2.7  Kotak Dialog User Information 



 

Editing Video Menggunakan Adobe Premiere Pro 

  

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 2.10  Proses Pengkopian File 

 

 

11. Program instalasi akan mulai dikopi seluruhnya. Proses ini ditandai dengan progress bar. 

Tunggu hingga proses instalasi selesai. 

 

12. Setelah selesai akan ditampilkan kotak dialog yang memberikan dua pilihan yaitu, Yes I want 

to restart my computer now dan No, I will restart my computer later. Pilih pilihan pertama 

dan klik tombol Finish untuk mengakhiri proses instalasi. Komputer akan direstart secara 

otomatis. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2.9 Kotak Dialog Start Copying Files 
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Gambar 2.12  Kotak Dialog Pembuka 

 

 

Software Adobe Premiere Pro telah terinstalasi pada komputer dan siap digunakan untuk 

proses capture (transfer) dan editing video dari DV Camcorder. 

 

Memahami Tampilan Awal 

Jalankan program Adobe Premiere Pro yang telah kita instal dengan cara pilih Start > All 

Programs > Adobe Premiere Pro. Tampilan awal program seperti gambar berikut. 

 

Membuat Project Baru dan Mengatur Seting Dasar 

Setelah menjalankan Adobe Premiere Pro maka langkah selanjutnya adalah membuat 

project baru dan mensetingnya, langkahnya : 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 2.11  Kotak Dialog Akhir Instalasi 
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Gambar 2.13 Tombol New Project 

1. Klik tombol New Project yang terdapat pada kotak dialog pembuka. Maka akan tampil kotak 

dialog New Project. 

2. Pada kotak dialog New Project atur Available Presets dengan pilihan DV‐PAL Standard 48 

KHz, 48 KHz menyatakan rate audio ketika direkam. Jika DV Camcorder menggunakan 

format video NTSC, pilih DV‐NTSC Standard 48 KHz. 

 

3. Lalu pilihlah lokasi penyimpanan file dengan klik tombol Browse. 

 

4. Isikan nama project pada text box Name dengan nama Baru1. Selanjutnya klik tombol OK 

untuk melanjutkan. Maka akan tampil area kerja Adobe Premiere Pro. 

 

Mengenal Area Kerja Adobe Premiere Pro 

Garis besar lingkungan kerja Adobe Premiere Pro terdiri dari 3 bagian utama, yaitu : 
 

1. Project Window, yang berada pada sebelah kiri atas. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 2.14  Kotak Dialog New Project 
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Gambar 2.15 Lingkungan Kerja Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 2.16 Tab Project di dalam Project Window 

2. Monitor Window, yang berada pada sebelah kanan atas. 

 

3. Timeline Window, yang berada di sebelah kiri bawah. 

 

4. Tools Window, yang berada di sebelah kiri bawah. 
 

 

Project Window 

Project Window adalah tempat dimana Anda menyimpan clip/footage (sebutan bagi file 

yang digunakan dalam digital video production) yang berupa file image, audio, title dan 

video yang akan digunakan dalam proses editing. Project Window memiliki 2 bagian 

yaitu Tab Project yang berisi daftar clip dan Tab Effects yang berisikan daftar efek audio, 

transisi audio, efek video dan transisi video. 
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Gambar 2.18 Tampilan Monitor Window 

 

 
 

Monitor Window 

Monitor Window terdiri dari Source Monitor Window dan Sequence Monitor Window, di 

sebelah kiri merupakan Source Monitor Window, sedangkan sebelah kanan merupakan 

Sequence Monitor Window. Source Monitor Window sangat berguna dalam proses 

trimming video nantinya, dan Sequence Monitor Window digunakan untuk melihat 

preview hasil editing pada Timeline. 

 

Timeline Window 

Timeline Window adalah tempat untuk menyusun dan menempatkan clip/footage untuk 

kemudian diedit. Dinamakan timeline karena bekerja berdasarkan waktu (secara 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 2.17 Tab Effects di dalam Project Window 
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Gambar 2.19 Tampilan Timeline Window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2.20 Tampilan Tools Window 

horisontal), sedangkan secara vertikal Timeline dibagi dalam “track”, yang terdiri dari 

track Video dan Audio. Adobe Premiere Pro menggunakan format SMPTE dalam satuan 

waktunya. SMPTE (Society of Motion Picture dan Television Engineers) adalah 

organisasi dari orang-orang film dan televisi internasional. Satuan format SMPTE adalah 

berdasarkan Jam:Menit:Detik:Frame. Misalnya posisi 00: 05: 15: 19 artinya kita berada 

pada posisi menit ke-5, detik ke-15 dan frame ke-19. Dengan format ini kita akan tahu 

durasi dari sebuah movie. 

 

Tools Window 

Tools Window berisikan tombol Selection Tool, Track Selection Tool, Ripple Edit Tool, 

Rolling Edit Tool, Rate Scratch Tool, Razor Tool, Slip Tool, Slide Tool, Pen Tool, Hand 

Tool, Zoom Tool yang nantinya banyak digunakan dalam proses editing video. 
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BAB 3 

 CAPTURE VIDEO DAN 

AUDIO 
 

 

 

 

 
 



Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar  3.1  Kaset Video Mini DV 

 
 

 

 
 

Gambar 3.2 Konektivitas DV Camcorder dengan PC lewat FireWire 

 

Proses selanjutnya adalah mengcapture audio dan video sebelum kita memulai proses 

editing, proses capture berguna untuk memindahkan hasil rekaman yang disimpan dalam 

kaset MiniDV dari kamera ke dalam komputer untuk dijadikan sebuah file dengan format 

video. 

 

Mengatur Tempat Penyimpanan File 

Sebelum memulai capture video Anda dapat mengatur tempat penyimpanan hasil capture 

dan file preview di dalam harddisk. Caranya, dari menu pilih Edit > Preferences > 

Scratch Disks. 
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Dalam Scratch Disks terdapat banyak pilihan, Anda dapat mengatur pilihan Captured 

Video untuk menentukan lokasi penyimpanan hasil capture video, sedangkan Captured 

Audio merupakan pengaturan lokasi penyimpanan hasil capture audio. Begitu pula 

dengan pilihan Video Previews dan Audio Previews yang merupakan pengaturan lokasi 

penyimpanan hasil preview video dan audio, sedangkan Conformed Audio merupakan 

pengaturan lokasi penyimpanan file audio hasil penyesuaian dari setting project  

(misalnya audio yang diimpor memiliki sample rate 32.000 Hz, sedangkan setting audio 

project Adobe Premiere Pro adalah 48.000 Hz, maka file audio yang diimpor akan 

digandakan dan disesuaikan dengan sample rate project Adobe Premiere Pro). Kemudian 

untuk menentukan lokasi penyimpanan pada masing-masing pilihan dapat digunakan 

tombol Browse. 

Memulai Proses Capture 

Pada latihan kali ini kita akan memulai dari awal proses capturing, berikut ini langkah- 

langkahnya : 

1. Tancapkan kabel FireWire ke dalam kamera DV kita. 

 

2. Lalu hidupkan komputer. 

 

3. Selanjutnya komputer akan mengenali DV Camcorder kita secara otomatis. Kemudian jalankan 

Adobe Premiere Pro dengan cara pilih Start > Programs > Adobe Premiere Pro. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 3.3 Mengatur tempat penyimpanan file 
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Gambar 3.5 Tombol New Project 

 

 

4. Maka akan tampil kotak dialog pembukan. Lalu klik pilihan New Project untuk membuat 

project baru. 

5. Setelah itu akan tampil kotak dialog New Project. Kemudian atur Available Presets dengan 

pilihan DV‐PAL Standard 48 KHz. Jika DV Camcorder menggunakan format video NTSC, 

pilih DV‐NTSC Standard 48 KHz. 

6. Lalu pilihlah lokasi penyimpanan file dengan klik tombol Browse. 

 

7. Isikan nama project pada text box Name dengan nama Capture. Selanjutnya klik tombol OK 

untuk melanjutkan. Maka akan tampil area kerja Adobe Premiere Pro. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 3.4  Kotak Dialog Pembuka 
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Gambar 3.7  Window Capture 

 

 

8. Setelah masuk lingkungan kerja Adobe Premiere Pro, kemudian menggunakan menu pilih File 

> Capture, atau tekan F5. 

 

9. Setelah itu akan tampil kotak dialog window Capture. Apabila PC terkoneksi dengan DV 

Camcorder secara baik maka pada window Capture ini akan tampil video yang ada pada DV 

Camcorder. 

10. Kemudian kita akan menyeting metode penamaan otomatis clip‐clip hasil capture kita, caranya 

di dalam Tab Logging pada pilihan Clip Data yang berada di dalam window Capture di 

sebelah kanan, ubahlah isian Tape Name dan Clip Name. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 3.6 Kotak dialog New Project 
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Gambar 3.9 Tab Setting 

 

 

11. Kemudian klik Tab Setting yang berada di samping Tab Logging. 

 

12. Lalu tentukan tempat penyimpanan hasil capture melalui pilihan Capture Location. Di dalam 

Capture Location terdapat dua isian yaitu Audio dan Video, Audio merupakan pengaturan 

lokasi penyimpanan hasil capture yang berupa file audio, sedangkan pilihan Video merupakan 

pengaturan lokasi penyimpanan hasil capture yang berupa file video. Cara pengaturan ini juga 

dapat dilakukan lewat menu Edit > Preferences > Scratch Disks, seperti pada bab sebelumnya. 

13. Lalu Atur Device Control yang letaknya masih berada di dalam tab Setting. Klik tombol 

Options. 

 

 

 

 

 

 

 

 

 

 
Gambar 3.8  Property Clip Data 
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Gambar 3.11 Kotak Dialog DV Device Control Options 

 

 

14. Selanjutnya akan ditampilkan kotak dialog DV Device Control Options. Pada Video Standard 

isi dengan format PAL. Device Brand, untuk merek DV Camcorder yang digunakan saat ini. 

Kemudian pilih Device Type sesuai dengan tipe dari DV Camcorder. Dan yang terakhir pilih 

metode Timecode Format. Apabila DV Camcorder telah terhubung dengan baik, maka pada 

pilihan Check Status akan tampil keterangan Online. Selanjutnya klik OK. 

15. Kemudian kita dapat mengendalikan DV Camcorder melalui window Capture menggunakan 

tombol‐tombol control yang berada di bawah Monitor. 

 
 

Melakukan Proses Capture 

Untuk melakukan proses capture menggunakan Window Capture langkah-langkahnya 

adalah : 

 

 

 

 
Gambar 3.12  Kumpulan Tombol Control 

 

 

 

 

 

 

 

 

 
Gambar 3.10  Device Control 
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Gambar 3.13  Tombol Play 

 
 
 
 
 

Gambar 3.14 Tombol Record 

 
 
 
 
 

Gambar 3.15 Tanda proses capture sedang berlangsung 

 

 

 

 
Gambar 3.16   Tombol Stop 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 3.17  Save Capture File 

1. Klik tombol Play pada control. 

 

2. Tekan tombol Record. Maka Adobe Premiere Pro akan mulai meng‐capture video anda. 
 

3. Untuk menghentikan proses capture, tekan tombol Stop. 
 

4. Selanjutnya akan tampil kotak dialog Save Capture File. Isi nama file, kemudian klik tombol 

OK. 
 

5. Setelah file video hasil capture disimpan, maka file‐file video tersebut akan tampil pada Project 

Window. 
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Gambar 3.18 Tampilan Project Window 
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BAB 4. 

 PROSES IMPORT DAN 

TRIMING 
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Biasanya setelah mengatur setting project dan melakukan capture pada permulaan project 

maka langkah-langkah selanjutnya adalah : 

 Mengimpor clip 

 

 Melakukan pemilihan scene (proses trimming) 

 

 Menyusun clip ke dalam Timeline Window 

 

 Memberikan Transisi 

 

 Memberikan Efek Video 

 

 Melakukan Transparansi/Superimpose 

 

 Melakukan Animasi 

 

 Memberi Title 

 

 Mengekspor Movie 

 

Mengimpor Clip 

Clip adalah sebutan untuk file-file yang dapat dipakai dalam project untuk membangun 

project di dalam Timeline, dapat berupa file image/gambar, file video dan file 

suara/audio. Format file yang disupport oleh Adobe Premiere Pro adalah QuickTime, 

Direct Show (Windows only), AVI (Windows only), WAV (Windows only), Adobe 

Photoshop, JPEG, SGI, Softimage PIC, Targa, TIFF, PICT, Cineon, RLA, Electric 

Image, Filmstrip, FLC/FLI, EPS (import only), Adobe Illustrator (import only). Berikut 

ini langkah-langkah mengimpor clip : 

1. Pada menu pilih File > Import. 

 

2. Maka akan tampil kotak dialog Import, lalu pilih file yang akan diimpor. Selanjutnya tekan 

Open. 
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Gambar 4.2 Tampilan daftar file yang telah diimpor di dalam Project Window 

 

 

 

 

 

Gambar 4.3  Prinsip dasar Trimming 

 

 

3. Maka file yang telah diimpor akan tampil di dalam Project Window. 
 

 

Melakukan Trimming 

File-file hasil capture dan clip hasil import masih merupakan potongan-potongan kasar 

yang masih harus dilakukan pemilihan atau penyortiran final. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 4.1 Tampilan kotak dialog Import 
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Gambar 4.4 Tampilan clip di dalam Source Monitor Window 

Pada dasarnya proses Trimming adalah menentukan In Point dan Out Point pada clip 

kemudian hasil trim tersebut dapat disusun ke dalam Timeline menggunakan metode Lift 

dan Overlay yang akan dijelaskan pada bahasan selanjutnya. Berikut ini langkah-langkah 

Trimming : 

1. Klik dua kali salah satu clip yang ada di dalam Project Window maka clip akan tampil dalam 

Source Monitor atau drag salah satu clip yang ada di dalam Project Window ke dalam Source 

Window. 

2. Kemudian untuk memainkan clip tersebut gunakan tombol Play atau dengan menggeser 

Playhead ke posisi waktu yang kita inginkan, lalu klik tombol Set In Point untuk menandai 

awal trimming. Tombol ini berada di sebelah kiri bawah pada Monitor Window. 

 

 

 

Gambar 4.5  Tombol Set In Point 
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Gambar 4.6 Proses penentuan In Point pada Source Monitor Window 

 

 

 
Gambar 4.7  Tombol Set Out Point 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4.8 Proses penentuan Out Point dalam Source Monitor Window 

 

 

3. Kemudian geser Playhead ke posisi waktu akhir lalu klik tombol Set Out Point untuk 

menandai akhir trimming. 

4. Apabila file atau clip yang kita trim merupakan file video yang tersusun atas video dan audio, 

maka kita dapat memilih format yang akan disusun ke dalam Timeline, dapat berupa video 

tanpa audio/suara atau hanya audio saja yang akan dimasukkan ke dalam Timeline. Tetapi 

apabila clip yang kita trim berupa audio saja, maka yang dapat kita masukkan ke Timeline juga 

berupa audio saja. Terdapat tiga pilihan Toggle Take Audio and Video yaitu Take Video, 
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Gambar 4.9 Toggle Take Video 

 
 
 

 
Gambar 4.10 Toggle Take Audio 

 
 
 

 
Gambar 4.11 Toggle Take Audio and Video 

Take Audio, Take Audio and Video. Toggle Take Video untuk mengatur hanya 

memasukkan format video saja tanpa suara/audio ke dalam Timeline, sedangkan Toggle Take 

Audio apabila diaktifkan maka hanya audio saja yang akan dimasukkan ke dalam Timeline, 

dan Toggle Take Audio and Video apabila diaktifkan maka hasil trimming yang dimasukkan 

ke dalam Timeline akan berupa video beserta audionya. 

5. Setelah clip ditrimming maka clip siap untuk disusun di dalam Timeline Window. Untuk 

menyusun clip hasil trimming ke dalam Timeline Window caranya drag video yang tampil 

pada Source Monitor Window ke dalam Timeline Window dengan cara drag seperti biasa. 

Apabila formatnya berupa video maka tempatkan clip hasil trimming pada Track Video, 

apabila format clip adalah audio maka tempatkan pada Track Audio, tetapi bila formatnya 

adalah video yang memiliki audio maka tempatkan dalam Track Video selanjutnya format 

audio yang bersamanya akan menyesuaikan diri menempati Track Audio yang kosong. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 4.12 Clip format video yang memiliki audio disusun dalam Timeline Window 
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Menyusun Clip ke dalam Timeline 

Setelah clip-clip yang akan kita pakai diimpor, maka langkah selanjutnya adalah 

menyusun clip-clip tersebut kedalam Timeline. Kita dapat secara langsung melakukan 

drag and drop pada clip-clip yang ada di dalam Project Window ke dalam Timeline 

Window apabila clip-clip tersebut tidak membutuhkan proses trimming. Begitu pula clip 

yang telah mengalami trimming, kita dapat langsung melakukan drag and drop video 

yang tampil pada Source Monitor Window setelah melakukan trimming. Tetapi kita dapat 

juga memakai metode Insert dan Overlay untuk memasukkan clip hasil trimming ke 

dalam Timeline Window. 

 

Metode Insert dan Metode Overlay 

Setelah dilakukan trimming dengan menentukan In Point dan Out Point pada salah satu 

clip video maka kita akan berlatih menggunakan metode Insert dan Overlay serta melihat 

perbedaan antara keduanya, langkah-langkahnya sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 
Gambar 4.13 Clip video yang tidak memiliki audio yang disusun di dalam Timeline 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 4.14 Clip format audio yang disusun di dalam Timeline Window 
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Gambar 4.15 Penyusunan clip di dalam Timeline Window 

1. Pilih salah satu clip yang ada di dalam Project Window, kemudian drag ke dalam Timeline 

Window dan letakkan pada Track Video 1. 

2. Kemudian pilih sebuah clip yang ada dalam Project Window, lalu drag ke dalam Timeline 

Window dan letakkan pada Track Video 1 tepat di sebelah clip pertama. Lalu klik tulisan Video 

2 untuk mengeset aktif Track Video 2, kemudian klik tulisan Audio 2 untuk mengaktifkan 

Track Audio 2. 

3. Setelah itu pada Source Monitor Window, pada tempat kita melakukan trimming, tekan 

tombol Insert. 

 

4. Maka clip hasil trimming akan dimasukkan ke dalam Timeline Window dengan cara 

memotong clip yang berada pada tempat Current Time Marker berada, kemudian clip 

potongannya akan berada didepan clip hasil trimming. 

 

 

 

 

 

 

 

 

 

 

 
Gambar 4.16 Tampilan Trimming dalam Source Monitor Window 

 
 
 

 
Gambar 4.17 Tombol Insert 
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Gambar 4.19 Tombol Overlay 

 

 

5. Kemudian tekan File > Undo untuk membatalkan pilihan Insert. 

 

6. Lalu pada Source Monitor Window klik tombol Overlay. 
 

7. Maka clip hasil trimming akan diletakkan di layer atau track yang tidak berisi clip/track 

kosong. 

 
 

Mengatur Tampilan Clip yang ada di dalam Track Video 

Tampilan Clip yang ada pada Track Video di dalam Timeline Window dapat diatur 

sedemikian rupa, terkadang kita membutuhkan tampilan yang kompleks untuk 

mempermudah kita dalam mencari letak adegan tertentu, tetapi kita juga membutuhkan 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 4.20 Tampilan penggunaan metode Overlay untuk memasukkan clip hasil trimming ke dalam Timeline 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 4.18 Penggunaan metode Insert untuk memasukkan clip hasil trimming ke dalam Timeline 
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Gambar 4.21 Letak tombol Collapse/Expand Track 

 

 

 

 

 
 

Gambar 4.22 Tampilan Track Video 1 setelah di expand 

tampilan yang sederhana untuk meringankan kinerja komputer. Untuk mengatur tampilan 

clip yang ada di dalam Track Video caranya : 

1. klik tombol panah Collapse/Expand Track yang berada pada Track Video 1. 
 

2. Maka tampilan Track Video 1 akan menjedi seperti pada gambar di bawah ini. 
 

3. Kemudian kita dapat memilih style tampilan clip menggunakan tombol Set Display Style 

yang ada di dalam Track Video 1. Kemudian klik tombol Set Display Style, maka akan tampil 

pop‐up menu yang berisi 4 pilihan pengaturan yaitu Show Head and Tail, Show Head Only, 

Show Frames dan Show Name Only. 

 

4. Selanjutnya pilih salah satu dari 4 pilihan yang ada. Tampilan Show Head and Tail akan 

menampilkan gambar awal dan akhir dari sebuah klip, pilihan Show Head Only akan 

menampilkan gambar awal saja pada clip, pilihan Show Frames akan menampilkan setiap 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.23 Tampilan ketika tombol Set Display Style di klik 
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Gambar 4.24 Tampilan berbagai display style 

 

 

 

 

 
 

Gambar 4.25 Tombol Collapse/Expand Track pada Track Audio 

 

 

 

 

 

Gambar 4.26 Tampilan Track Audio setelah di expand 

frame dari sebuah clip, sedangkan pilihan Show Name Only hanya akan menampilkan nama 

dari clip saja. 

 

Mengatur Tampilan Clip yang ada di dalam Track Audio 

Seperti halnya tampilan clip dalam Track Video, tampilan clip di dalam Track Audio juga 

dapat diatur sedemikian rupa. Jika clip pada Track Video menampilkan gambar tempilan 

video atau still image, maka clip yang ada dalam Track Audio akan menampilkan bentuk 

gelombang audio atau waveform. Untuk mengatur display style pada Track Audio 

caranya : 

1. Klik tombol panah Collapse/Expand Track yang ada di dalam Track Audio 1. 
 

2. Maka tampilan Track Audio 1 akan menjadi seperti pada gambar di bawah ini. 
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Gambar 4.30 Tampilan Zoom Toggle 

 

 

 

 

 

 
Gambar 4.27 Tampilan pop-up menu apabila tombol Set Display Style di klik 

 

 

 
Gambar 4.28 Tampilan pilihan Show Name Only 

 
 
 
 

Gambar 4.29 Tampilan pilihan Show Waveform 

3. Kemudian klik tombol Set Display Style, maka akan tampil pop‐up menu yang berisi dua 

pilihan, yaitu Show Waveform dan Show Name Only. Pilihan Show Waveform akan 

menampilkan bentuk gelombang audio pada clip, sedangkan pilihan Show Name Only hanya 

akan menampilkan nama file dari clip tersebut. 

4. Klik salah satu pilihan tersebut. 
 

 

Menggunakan Zoom Toggle Untuk Melakukan Zoom-In dan 

Zoom-Out 

Untuk memudahkan kita dalam melakukan Zoom-In dan Zoom-Out pada Timeline, kita 

dapat menggunakan Zoom Toggle dengan menggeser Playhead Zoom Toggle atau dapat 

juga dengan melakukan klik pada tombol Zoom-In dan Zoom-Out. 
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Gambar 4.33 Tombol Zoom Tool yng ada di dalam Tools Window 

 

 

Gambar 4.34 Tampilan kursor Ripple Edit 

 

 

Selain menggunakan Zoom Toggle kita juga dapat menggunakan tombol Zoom Tool 

yang ada di dalam Tools Window. 

 

Mengatur Durasi Clip 

Untuk mengatur durasi clip yang berada di dalam Timeline Window caranya dekatkan 

kursor mouse ke posisi akhir clip, sehingga akan tampil kursor Ripple Edit berwarna 

merah dengan panah berwarna hitam. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 4.31 Tampilan Timeline Window sebelum dilakukan Zoom-In 

 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 4.32 Tampilan Timeline Window setelah dilakukan Zoom-In 
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Gambar 4.36 Tampilan clip yang telah diubah durasinya 

 

 

 

 

 

 

 

 

 
Gambar 4.37 Penggeseran Current Time Marker untuk membantu mempermudah pemotongan clip 

 

 

Kemudian drag maju dan mundur untuk merubah durasi clip. 
 

 

Memotong Clip 

Untuk memotong clip yang telah disusun dalam Timeline Window, kita dapat 

menggunakan tombol Razor Tool yang berada di dalam Tools Window. Berikut ini 

langkahnya : 

1. Susun sebuah clip ke dalam Timeline Window. Kemudian geser Current Time Marker ke posisi 

yang akan dilakukan pemotongan. 

 

 

 

 

 

 

 

 

 

 

Gambar 4.35 Tampilan clip sebelum diubah durasinya 
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Gambar 4.38 Tombol Razor Tool 

 

 

 

 

 

 

 

 

 

 
Gambar 4.38 Clip yang terpotong menjadi dua bagian 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 4.39 Tampilan clip yang telah terpilih 

2. Kemudian klik tombol Razor Tools yang berada dalam Tools Window. 
 

3. Lalu klik satu kali pada clip tepat pada posisi Current Time Marker berada. 

 

4. Maka clip akan terpotong menjadi dua bagian. 
 

 

Menghapus Clip 

Pada suatu saat mungkin kita berniat untuk menghapus clip (baik itu berupa audio 

maupun video) yang ada di dalam Timeline Window karena berbagai alasan, misalnya 

tidak jadi terpakai. Maka untuk menghapus clip yang ada di dalam Timeline Window 

caranya pilih salah satu clip yang akan dihapus yang berada di dalam Timeline Window, 

dengan cara klik satu kali pada clip tersebut. Kemudian tekan tombol Delete yang ada di 

keyboard komputer. Maka clip tersebut akan terhapus. 
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Gambar 4.40 Tampilan property Motion dalam Tab Effect Controls 

 

 

 

 

 

 

 

 

 

 

 
Gambar 4.41 Tampilan awal clip sebelum mengalami perubahan nilai 

Property Motion 

Setiap clip yang ada di dalam Timeline Window memiliki property Motion, untuk 

menampilkan property clip caranya klik pada clip yang ada di dalam Timeline Window 

maka akan tampil Tab Effect Controls yang menampilkan property Motion. 

Property Motion berisikan pilihan-pilihan berupa : 

 Position, berfungsi untuk mengatur letak atau posisi clip 

 

 Scale, berfungsi mengatur skala clip, kita dapat melakukan perbesaran dan perkecilan 

menggunakan pilihan ini. 

 Rotation, berfungsi mengatur rotasi atau perputaran clip. 

 

 Anchor Point, berfungsi mengatur letak titik pusat perputaran clip. 

 

Gambar-gambar berikut ini merupakan contoh dari perubahan nilai pada pilihan Position, 

Scale, Rotation dan Anchor Point. 



Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 
Gambar 4.42 Perubahan nilai Position 

 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4.43 Hasil perubahan nilai Position 

 
 
 
 
 
 
 
 
 
 

Gambar 4.44 Perubahan nilai pada Scale 

 
 
 
 
 
 
 
 
 

Gambar 4.45 Tampilan perubahan nilai Scale 

 
 
 
 

 
Gambar 4.46 Perubahan nilai Rotation 
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Gambar 4.47 Tampilan perubahan nilai Rotation 

 
 
 
 
 
 

Gambar 4.48 Perubahan nilai Anchor Point 

 
 
 
 
 
 
 
 
 
 

 
Gambar 4.49 Tampilan perubahan nilai Anchor Point dan Rotation 
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BAB 5 

 MEMBERIKAN 

TRANSISI 
 

 

 

 

 
 



 

Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

Gambar 4.18 Metode transisi pada workspace A/B Editing 

Metode pemberian transisi pada clip disesuaikan dengan workspace yang dipakai dalam 

project, terdapat dua macam workspace editing dalam Adobe Premiere, pada versi 5 dan 

6 masih menyertakan kedua model yaitu A/B Editing dan Single Track Editing 

sedangkan pada versi Pro atau 7 workspace A/B Editing telah dihilangkan dan hanya 

menggunakan satu macam workspace yaitu Single Track Editing. 

 

Workspace A/B Editing 

Pada workspace jenis ini transisi memiliki track/layer sendiri. Biasanya metode ini 

digunakan oleh para pemula yang baru mengenal digital video editing, dan sedang 

mempelajari metode pemberian transisi. Pemberian transisi menggunakan workspace 

jenis ini tidak akan dijelaskan lebih lanjut, karena kita tidak akan menggunakannya pada 

Adobe Premiere Pro. 

 

Workspace Single Track Editing 

Pada workspace model ini transisi tidak memiliki track sendiri, jadi Premiere 

menggunakan frame yang tersisa dari hasil trimming sebagai durasi transisi. Frame sisa 

tersebut dinamakan Head Material dan Tail Material. 

Apabila clip tidak memiliki frame sisa maka kita dapat mengatur durasi transisi dan 

mengubah posisi transisi dengan metode Center of Cut, Start of Cut dan End of Cut. 

 

 

 

 

 

 

 

 

 

 
Gambar 4.19 Metode transisi pada workspace Single Track Editing 
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Gambar 4.20 Berbagai posisi transisi dalam Single Track Editing 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.1 Clip pertama yang disusun di dalam Timeline Window 

 

 
 

Persiapan Latihan 

Dalam latihan memberi transisi digunakan setting project DV-PAL Standard 48 KHz, 

kemudian impor dua clip video dengan format file *.avi. File *.avi bisa didapat dari hasil 

capture camera video digital atau dari sumber lainnya. Dapat pula digunakan dua clip 

dengan format image (format file BMP dan JPG) untuk latihan. Yang terpenting apabila 

kita menggunakan setting project DV-PAL Standard maka ukuran frame (frame size) 

video dan image yang digunakan adalah 720 x 576 pixel. 

 

Latihan Memberi Transisi 

Untuk lebih jelasnya maka akan dijelaskan langkah demi langkah proses pemberian 

transisi pada workspace Single Track Editing, caranya : 

1. Import clip kedalam Project Window. 

 

2. Kemudian susun salah satu clip yang ada di dalam Project Window ke dalam Track Video 1 di 

dalam Timeline Window dengan melakukan drag and drop. 
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Gambar 5.2 Current Time Marker digeser kedepan untuk memberi durasi transisi 

3. Geser Current Time Marker ke posisi waktu 00:00:10:06 untuk memberikan durasi transisi. 
 

4. Setelah itu drag lagi salah satu clip yang ada di dalam Project Window ke dalam Timeline 

Window. Tempatkan clip tepat pada posisi Current Time Marker pada Track Video 1, overlap 

dengan clip pertama. 

 

5. Kemudian klik Tab Effects pada Project Window. Expandlah pilihan Video Transitions, 

selanjutnya expand pula pilihan Iris. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.3 Penempatan clip kedua pada Track Video 1 yang sengaja dibuat overlap dengan clip pertama 
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Gambar 5.5 Pemberian transisi Spin pada Track Video 1 

 

 

6. Selanjutnya drag pilihan transisi Iris Diamond ke dalam Timeline Window, tempatkan di Track 

Video 1 tepat setelah Current Time Marker. 

7. Kita dapat melihat hasil pemberian transisi dengan melakukan Play pada Sequence Monitor 

Window atau dengan menekan Space Bar pada keyboard komputer (Adobe Premiere Pro tidak 

memerlukan proses render untuk memainkan hasil transisi). 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.4 Tab Effects di dalam Project Window 
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Gambar 5.7 Pemilihan transisi yang akan diatur durasinya 

 

 
 

Mengatur Durasi Transisi 

Setelah diberikan transisi, mungin kita akan mengatur durasi transisi tersebut agar sesuai 

dengan yang kita inginkan. Untuk mengatur durasi berikut ini langkah-langkahnya : 

1. Pilih transisi yang akan diatur durasinya dengan cara klik satu kali pada transisi tersebut. 

Transisi yang aktif atau telah terpilih akan berwarna hitam seperti pada gambar di bawah ini. 

2. Maka Tab Effect Controls yang ada di dalam Monitor Window akan tampil seperti pada 

gambar di bawah ini. Pada Tab Controls inilah kita melakukan pengaturan durasi transisi. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.6 Melihat hasil transisi dalam Sequence Monitor Window 
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Gambar 5.9 Perubahan nilai pada pilihan Duration 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.10 Tampilan Tab Effect Controls setelah panjang durasi transisi dirubah 

 

 

3. Kemudian ubahlah nilai pilihan Duration menjadi 00:00:02:10. Maka panjang durasi akan 

berubah. 

 

Mengatur Posisi Transisi 

Sesuai dengan kaidah yang berlaku dalam workspace Single Track Editing, maka kita 

dapat merubah posisi transisi dengan metode Center of Cut, Start of Cut dan End of Cut. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.8 Tampilan Tab Effect Controls dalam Monitor Window 



 

Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

Gambar 5.11 Tampilan pilihan Alignment di dalam Tab Effect Controls yang berfungsi mengatur posisi transisi 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.12 Tampilan pop-up menu pilihan Alignment 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 5.13 Tampilan Alignment yang menggunakan posisi transisi Start at Cut 

Pengaturan posisi transisi dilakukan menggunakan pilihan Alignment yang berada pada 

Tab Effect Controls di dalam Monitor Window. 
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Gambar 5.14 Tampilan Alignment yang menggunakan posisi transisi Center at Cut 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 5.15 Tampilan posisi transisi Center at Cut di dalam Timeline Window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Gambar 5.16 Tampilan transisi yang menggunakan posisi End at Cut di dalam Tab Effect Controls 
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Menghapus Transisi 

Pada suatu saat mungkin kita perlu menghapus transisi yang telah kita buat, maka untuk 

menghapus transisi caranya pilih transisi yang akan dihapus kemudian tekan tombol 

Delete yang ada dalam keyboard komputer. 

 

Mengganti Transisi 

Sedangkan untuk mengganti transisi yang telah ada dengan transisi jenis lainnya, yang 

perlu kita lakukan adalah menimpa transisi yang lama dengan transisi yang baru pada 

posisi yang sama, maka transisi yang lama akan digantikan dengan transisi yang baru. 

Misalnya transisi lama kita adalah jenis Spin, kemudian kita akan menggantinya dengan 

jenis Cross Dissolve, maka yang perlu kita lakukan adalah mengambil transisi dari 

jendela Tab Effects di Project Window, kemudian kita drag and drop kedalam Timeline 

Window tepat pada transisi yang lama, maka secara otomatis transisi Spin akan berubah 

menjadi Cross Dissolve dengan durasi yang sama. 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 5.17 Tampilan transisi yang menggunakan posisi End at Cut di dalam Timeline Window 
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BAB 6 

 MEMBERI EFEK VIDEO 
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Sebagai alat editing profesional maka Adobe Premiere Pro juga dilengkapi dengan 

fasilitas Visual Effects. Kita dapat mengaplikasikan efek-efek visual yang menarik pada 

clip-clip yang telah kita susun di dalam Timeline Window. 

 

Memberi Efek Pada Clip Video 

Kita akan mencoba untuk mengaplikasikan efek video pada clip yang ada dalam Timeline 

Window, sebelum masuk dalam latihan maka kita harus mempersiapkan project terlebih 

dahulu. 

 

Persiapan Latihan 

Dalam latihan memberi transisi digunakan setting project DV-PAL Standard 48 KHz, 

kemudian impor tiga clip video dengan format file *.avi. File *.avi bisa didapat dari hasil 

capture camera video digital atau dari sumber lainnya. Dapat pula digunakan dua clip 

dengan format image (format file BMP dan JPG) untuk latihan. Yang terpenting apabila 

kita menggunakan setting project DV-PAL Standard maka ukuran frame (frame size) 

video dan image yang digunakan adalah 720 x 576 pixel. Pada latihan ini ketiga clip 

video telah digabungkan dengan memberi transisi. Lalu akan diberikan efek video pada 

salah satu clip tersebut. 

 

Latihan Memberi Efek Video 

Setiap clip dapat diberi efek lebih dari satu jenis efek. Untuk memberikan efek visual 

pada clip video berikut ini langkah-langkahnya : 

1. Buka Tab Effects yang ada di dalam Project Window, kemudian expandlah pilihan Video 

Effects. Selanjutnya expand pula pilihan Adjust. 
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Gambar 6.2 Tampilan clip yang diberi efek di dalam Timeline Window 

 

 

2. Lalu pilih efek Posterize, kemudian drag efek tersebut ke dalam Timeline Window, lalu 

tempatkan pada salah satu clip yang berada dalam Track Video. 

3. Lalu tampilan Tab Effect Controls yang berada di dalam Monitor Window tampilannya akan 

tampak seperti pada gambar di bawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6.1 Pilihan berbagai efek video di dalam Tab Effects 
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Gambar 6.4 Perubahan nilai Level pada efek Posterize 

 

 

4. Kemudian expand efek Posterize yang berada pada pilihan Video Effects, lalu ubah nilai Level 

menjadi 2. 

5. Maka tampilan clip yang diberi efek Posterize akan tampak seperti pada gambar di bawah ini. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 6.3 Tampilan Tab Effect Controls di dalam Monitor Window 
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Gambar 6.6 Current Time Marker yang digeser pada posisi awal clip yang diberi efek Posterize 

 

 
 

Menganimasikan Efek Video 

Setiap property dari efek yang terdapat dalam Tab Effects Control yang memiliki tombol 

time-vary (stopwatch) dapat dianimasikan nilainya, agar terlihat dinamis. Untuk 

menganimasikan efek video digunakan metode keyframing. Berikut ini langkah-langkah 

animasi efek video : 

1. Geser Current Time Marker ke posisi awal pada clip video yang telah diberi efek Posterize, 

kemudian pilih clip yang telah diberi efek Posterize dengan cara klik satu kali untuk 

mengaktifkannya. 

2. Lalu pada pilihan Video Effects yang ada di dalam Tab Effect Controls, klik Toggle Animation 

yang bergambar stopwatch untuk memulai proses animasi keyframing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 6.5 Tampilan clip dalam Sequence Monitor Window 
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Gambar 6.9 Current Time Marker yang digeser ke posisi akhir clip 

 

 

 

 
Gambar 6.10 Perubahan nilai Level pada posisi akhir clip 

 

 
 

3. Biarkan nilai Level tetap pada angka 2, kemudian geser Current Time Marker ke posisi akhir 

dari clip. 

4. Lalu ubah nilai Level pada Video Effects menjadi 10. 
 

5. Maka tampilan clip pada Sequence Monitor Window akan tampak seperti pada gambar 

berikut ini. 

 

 

 

 
Gambar 6.7 Pilihan Video Effects di dalam Tab Effect Controls 

 

 

 
Gambar 6.8 Tampilan Toggle Animation 
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Gambar 6.12 Memodifikasi keyframe 

 

 

6. Maka apabila Timeline dimainkan menggunakan Play atau tombol Space Bar pada keyboard 

hasilnya akan terjadi perubahan berangsur‐angsur dari nilai Level, dari nilai 2 menjadi nilai 10. 

 

Memodifikasi Keyframe Efek 

Pada penerapan efek yang dianimasikan pastilah memiliki keyframe, kita dapat 

memodifikasi keyframe, untuk memodifikasi durasi yang harus kita lakukan adalah 

menggeser keyframe pada posisi yang kita inginkan. 

Sedangkan untuk menghapus keyframe yang harus kita lakukan adalah memilih keyframe 

yang akan dihapus, maka setelah keyframe tersebut terpilih lalu tekan tombol Delete pada 

keyboard. 

 

Menghapus Efek 

Untuk menghapus efek yang tidak terpakai caranya pilih efek yang akan dihapus di dalam 

pilihan Video Effects di dalam Tab Effect Controls, kemudian tekan Delete pada 

keyboard komputer. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6.11 Tampilan perubahan nilai Level menjadi 10 dalam Sequence Monitor Window 



Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 
 

Galeri Efek Video 

Adobe Premiere Pro memberikan banyak pilihan efek video yang terdapat pada tab Video 

Effects. Berikut ini adalah contoh tampilan efek-efek tersebut. 

 

 

 

 
 

Gambar 6.12 Tampilan efek yang telah terpilih di dalam pilihan Video Effects pada Tab Effect Controls 
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Gambar 6.13 Galeri Efek Video 
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BAB 7 

 TEKNIK EDITING TINGKAT 

LANJUT 
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Gambar 7.1 Tampilan window Universal Counting Leader Setup 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.2 Tampilan Universal Counting Leader di dalam Project Window 

Memasang Universal Counting Leader 

Untuk menghitung mundur sebelum masuk ke video utama seringkali digunakan 

Universal Counting Leader. Untuk membuat Universal Counting Leader caranya : 

1. Pilih File > New > Universal Counting Leader. 
 

2. Maka akan tampil window Universal Counting Leader Setup. Kita dapat mengganti warna 

jika diinginkan, kemudian aktifkan pilihan Cue Blip apabila kita membutuhkan suara beep 

pada saat hitungan mundur. Kemudian tekan OK. 

3. Maka clip Universal Counting Leader akan tampil dalam Project Window, untuk memakainya 

tinggal lakukan drag and drop ke dalam Timeline Window. 
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Gambar 7.4 Tampilan clip Bars and Tone di dalam Project Window 

 

 
 

Memasang Clip Bars and Tone 

Selain Universal Counting Leader kita juga dapat menambahkan clip Bars and Tone yang 

berfungsi untuk alat bantu kalibrasi. Biasanya ditambahkan 6 detik Bars and Tone di awal 

movie. Untuk membuat Bars and Tone caranya : 

1. Pilih File > New > Bars and Tone. 

 

2. Maka clip Bars and Tone akan muncul pada Project Window, untuk memakainya lakukan drag 

and drop ke dalam Timeline Window. 

 

 

 

 

 

 

 

 

 
Gambar 7.3 Tampilan clip Universal Counting Leader 
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Gambar 7.6 Tampilan clip Black Video di dalam Project Window 

 

 
 

Membuat Black Video 

Apabila kita ingin menyisipkan background hitam ke dalam video kita dapat 

menggunakan clip Black Video. Selain itu kita dapat menambahkan clip Black Video ke 

dalam Timeline pada awal movie dengan tujuan untuk menyediakan waktu bagi proses 

perekaman movie di video recorder. Untuk membuat Black Video caranya : 

1. Pilih File > New > Black Video. 

 

2. Maka clip Black Video akan tampil di dalam Project Window, untuk memakainya lakukan 

drag and drop ke dalam Timeline Window. 

 

Proses Superimposing 

Setiap clip yang berada dalam Track Video pasti memiliki property transparansi, dalam 

Adobe Premiere Pro sebutan untuk transparansi adalah Opacity. Dengan menggunakan 

 

 

 

 

 

 

 

 

 

 
Gambar 7.5 Tampilan clip Bars and Tone 
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Gambar 7.7 Tampilan clip Black Video yang disusun pada Track Video 1 di dalam Timeline Window 

fasilitas Opacity kita dapat menggabungkan dua buah clip yang salah satunya akan 

dijadikan background, teknik penggabungan inilah yang dinamakan Superimpose. Teknik 

Superimpose hanya berlaku untuk clip yang berada pada Track Video 2, 3 dan 

seterusnya. Kita akan berlatih menggunakan teknik Superimposing untuk membuat 

transisi dissolve secara manual, menggabungkan gambar yang memiliki Alpha Channel 

dan penggabungan gambar yang tidak memiliki Alpha Channel. 

 

Membuat Transisi Dissolve Secara Manual 

Pada latihan ini kita akan mencoba membuat transisi dissolve sederhana menggunakan 

fasilitas Opacity. Berikut ini langkah-langkahnya : 

1. Buat clip Black Video dengan cara pilih File > New > Black Video. 

 

2. Maka clip Black Video akan tampil di dalam Project Window. Kemudian drag clip Black Video 

ke dalam Timeline Window. Letakkan pada Track Video 1. 

3. Selanjutnya drag salah satu clip video yang ada di dalam Project Window ke dalam Timeline 

Window, lalu tempatkan pada Track Video 2, buat posisinya overlap dengan clip Black Video, 

seperti terlihat pada gambar di bawah ini. 
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Gambar 7.9 Pemilihan clip kedua 

 

 

4. Lalu pilih clip kedua untuk mengaktifkan Tab Effect Controls dengan cara melakukan klik satu 

kali pada clip tersebut. 

5. Lalu expand pilihan Opacity yang ada pada pilihan Fixed Effects di dalam Tab Effect Controls. 

Secara default Opacity akan memiliki nilai 100. 

 

6. Kemudian kita akan memulai proses keyframing, pertama geser Current Time Marker ke 

posisi awal clip kedua. 

 

 

 

 

 

 

 

 

 

 
Gambar 7.10 Pilihan Opacity yang ada di dalam Tab Effect Controls 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.8 Penyusunan clip video kedua yang diletakkan pada Track Video 2 sengaja dibuat overlap dengan clip Black Video 
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Gambar 7.12 Tombol Add/Remove Keyframe 

 

 

 

 

 

 

 
 

Gambar 7.14 Tampilan Sequence Monitor Window yang menampilkan clip Black Video 

 

 

7. Kemudian klik tombol Add/Remove Keyframe yang terdapat di sebelah kanan pilihan Opacity 

dalam Tab Effect Controls untuk membuat keyframe baru. 

8. Maka akan tercipta sebuah keyframe baru di sebelah kanan. Kemudian ubah nilai Opacity 

menjadi 0. 

 

9. Maka tampilan dalam Sequence Monitor Window akan tampak tampilan clip Black Video, 

karena Opacity clip video pertama yang berada di Track Video 2 dirubah nilainya menjadi 0. 

10. Selanjutnya geser Current Time Marker ke posisi waktu akhir clip pertama, seperti pada 

gambar dibawah ini 

 

 

 
Gambar 7.13 Pembuatan keyframe dan perubahan nilai Opacity 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.11 Penggeseran Current Time Marker ke posisi awal clip kedua 
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Gambar 7.16 Perubahan nilai Opacity dan penambahan keyframe 

 

 

 

 

 

 

 

 

 
Gambar 7.17 Tampilan clip pada Sequence Monitor Window 

 

 

11. Lalu ubah nilai Opacity yang ada di dalam Tab Effect Controls menjadi 100, maka secara 

otomatis akan tercipta sebuah keyframe. 

12. Tampilan Sequence Monitor Window akan tampak seperti pada gambar dibawah ini. 
 

13. Maka jika movie dimainkan akan terlihat sebuah transisi dissolve sederhana dari tampilan 

hitam kemudian berangsur‐angsur menampilkan clip pertama. 

 

Menggunakan Adobe Photoshop CS Untuk Membuat Clip Yang 

Memiliki Alpha Channel 

Berbagai produk Adobe dapat diintegrasikan untuk memperoleh hasil kreativitas video 

yang maksimal. Kali ini kita akan mencoba mengintegrasikan Adobe Photoshop CS 

dengan Adobe Premiere Pro. Adobe Photoshop CS digunakan untuk membuat title, 

walaupun dalam Adobe Premiere Pro telah disediakan fasilitas Adobe Title Designer 

 

 

 

 

 

 

 

 

 

 
Gambar 7.15 Penggeseran Current Time Marker ke posisi akhir clip pertama 
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Gambar 7.18 Kotak dialog New 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.19 Area kerja Adobe Photoshop CS 

yang akan dijelaskan cara penggunaannya dalam bab berikutnya. Untuk membuat title 

menggunakan Adobe Photoshop CS caranya : 

1. Jalankan aplikasi Adobe Photoshop CS dari Start Menu > All Programs > Adobe Photoshop CS. 

 

2. Buat project baru dengan cara pilih File > New. 

 

3. Maka akan tampil kotak dialog New. Lalu isikan Name = alpha‐channel, Width = 720 pixels, 

Height = 576 pixels, Resolution = 72 pixels/inch, Color Mode = RGB Color, dan Pixel Aspect 

Ratio = D1/DV PAL (1.066) kemudian tekan OK. 

4. Akan tampil area kerja Adobe Photoshop CS. 
 

5. Dengan menggunakan tools yang ada, buat image yang terdiri dari shape dan text. Lalu 

simpan dengan nama file produser.psd. 
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Untuk mengetahui cara penggunaan Adobe Photoshop CS lebih lanjut silakan baca buku 

yang khusus membahas cara penggunaan Adobe Photoshop CS. 

 

Metode Penggabungan Clip Yang Memiliki Alpha Channel 

Selain digunakan untuk membuat transisi sederhana, teknik Superimpose juga 

dipergunakan untuk menggabungkan clip yang memiliki Alpha Channel. Berikut ini 

langkah-langkahnya : 

1. Import file yang memiliki Alpha Channel, dalam latihan kali ini digunakan file bernama 

produser.psd (dibuat menggunakan Adobe Photoshop dengan ukuran image 720 x 576 pixel, 

dengan warna background transparan). Untuk melakukan Import pilih File > Import. 

2. Kemudian akan tampil kotak dialog Import, kemudian pilih file produser.psd. Lalu tekan 

Open. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7.20 Tampilan file produser.psd dalam Adobe Photoshop CS 
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Gambar 7.22 Kotak dialog Import Layered File 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7.23 Tampilan clip produser.psd dalam Project Window 

 

 

3. Setelah itu akan tampil kotak dialog Import Layered File : produser psd, kemudian pada 

pilihan Import As pilih Footage, sedangkan pada Layer Options pilih Merged Layers. 

Kemudian tekan OK. 

4. Maka file produser akan tampil di dalam Project Window. 
 

5. Kemudian kita akan menyusun clip ke dalam Timeline Window. Langkah pertama, drag salah 

satu clip yang ada di dalam Project Window ke dalam Timeline Window, kemudian tempatkan 

pada Track Video 1. Clip ini akan berfungsi sebagai background. 

Gambar 7.21 Tampilan window Import 
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Gambar 7.24 Penyusunan clip produser.psd pada Track Video 2 dalam Timeline Window 

 

 
 

6. Lalu drag clip produser.psd ke dalam Timeline Window, letakkan pada Track Video 2, tepat 

diatas clip pertama. 

7. Maka tampilan movie dalam Sequence Monitor Window akan tampak seperti pada gambar di 

bawah ini. 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7.24 Penyusunan clip pertama yang difungsikan sebagai background 

 
 
 
 
 
 
 
 
 
 

Gambar 7.25 Tampilan clip pertama dalam Sequence Monitor Window 
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Gambar 7.26 Tampilan clip sampah-bulu-30.avi 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 7.27 Tampilan clip sampah-bulu-26.avi 

 

 
 

Metode Penggabungan Clip Yang Tidak Memiliki Alpha Channel 

Pada latihan ini kita akan mencoba menggabungkan clip yang tidak memiliki Alpha 

Channel menggunakan fasilitas Opacity. Kita akan menggabungkan dua clip yaitu clip 

sampah-bulu-30.avi dan sampah-bulu-26.avi. 
 

Berikut ini langkah-langkahnya : 
 

1. Drag clip sampah‐bulu‐30.avi yang ada dalam Project Window ke dalam Timeline Window, 

letakkan pada Track Video 1. 

 

 

 

 

 

 

 

 
Gambar 7.25 Tampilan produser.psd dalam Sequence Monitor Window 



 

Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.29 Clip sampah-bulu-26.avi yang diletakkan pada Track Video 2 

 

 

2. Kemudian drag clip sampah‐bulu‐26.avi yang ada dalam Project Window ke dalam Timeline 

Window, letakkan pada Track Video 2. 

3. Lalu pilih clip sampah‐bulu‐26.avi yang ada di dalam Timeline Window untuk menampilkan 

Tab Effect Controls. 

4. Kemudian expand pilihan Opacity yang ada dalam Tab Effects Controls. Selanjutnya ubah nilai 

Level menjadi 50. 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.28 Clip sampah-bulu-30.avi diletakkan pada Track Video 1 dalam Timeline Window 
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Gambar 7.31 Tampilan movie di dalam Sequence Monitor Window 

 

 

5. Maka tampilan movie pada Sequence Monitor Window akan tampak seperti pada gambar di 

bawah ini. 

 

Bermain Dengan Durasi 

Mungkin suatu saat kita membutuhkan adegan lambat dan adegan yang dipercepat untuk 

memenuhi tuntutan cerita. Dalam bahasan kali ini kita akan berlatih membuat efek slow 

motion, fast motion, freeze frame dan reverse motion. 

 

Slow Motion 

Slow motion atau adegan lambat pada prinsipnya adalah mengurangi kecepatan dan 

menambah durasi dari clip asli. Berikut ini langkah-langkah membuat slow motion : 

1. Susun salah satu clip yang ada di dalam Project Window ke dalam Timeline Window. 

 

 

 

 

 

 

 

 

 

 
Gambar 7.30 Perubahan nilai Opacity pada clip sampah-bulu-26.avi 
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Gambar 7.33 Tampilan pop-up menu 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7.34 Kotak dialog Clip Speed/Duration 

 

 

2. Kemudian pilih clip tersebut, selanjutnya klik kanan pada clip tersebut. Maka akan tampil pop‐ 

up menu. 

3. Selanjutnya pilih Speed/Duration. Maka akan tampil kotak dialog Clip Speed/Duration. 
 

 

 

 

 

 

 

 

 

 

 
Gambar 7.32 Sebuah clip yang disusun dalam Timeline 
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Gambar 7.35 Perubahan nilai Speed 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7.36 Perubahan durasi dari clip yang ada dalam Timeline 

4. Selanjutnya ubah nilai Speed menjadi lebih rendah dari 100%, misalnya 50%. 
 

5. Maka secara otomatis nilai Duration juga mengalami perubahan, yaitu penambahan waktu. 

Selanjutnya klik OK. 

6. Lalu di dalam Timeline Window juga akan terjadi perubahan durasi dari clip. 
 

7. Jalankan movie dan lihat perubahan yang terjadi. 

 
Fast Motion 

Fast Motion disebut juga adegan cepat, pada prinsipnya fast motion adalah menambah 

kecepatan (speed) dan mengurangi panjang durasi. Berikut ini langkah-langkah untuk 

membuat fast motion : 

1. Susun salah satu clip yang ada dalam Project Window ke dalam Timeline Window. 

 

2. Kemudian klik kanan pada clip tersebut, sehingga akan tampil jendela pop‐up menu. 



 

Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.37 Kotak dialog Clip Speed/Duration 

 

 

 

 

 

 

 

 

 

 
Gambar 7.38 Perubahan nilai Speed dan pengurangan durasi 

3. Selanjutnya pada jendela pop‐up menu pilih Speed/Duration. Maka akan tampil kotak dialog 

Clip Speed/Duration. 

4. Untuk membuat fast motion ubah nilai Speed menjadi lebih dari 100%, misalnya 150%. Maka 

secara otomatis nilai Duration akan berkurang. 

5. Lalu tekan OK. 

 

6. Maka clip yang berada dalam Timeline akan mengalami perubahan waktu berupa 

pengurangan durasi. 
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Gambar 7.40 Clip yang disusun di dalam Timeline Window 

 

 
 

Freeze Frame 

Freeze frame atau menghentikan klip adalah mode manipulasi waktu yang lain selain fast 

motion dan slow motion. Dengan menggunakan metode ini kita dapat menghentikan clip 

di tengah movie untuk kemudian memainkannya lagi. Berikut ini langkah-langkahnya : 

1. Susun salah satu clip yang ada dalam Project Window ke dalam Timeline Window. 
 

2. Kemudian potong clip tersebut tepat ditengah menggunakan Razor Tool yang ada di dalam 

Tools Window. 

 

 

 
Gambar 7.41 Tombol Razor Tool 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 7.39 Terjadi pengurangan durasi pada clip yang ada di dalam Timeline Window 
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Gambar 7.43 Tombol Selection Tool 

 

 

3. Lalu klik tombol Selection Tool yang terletak dalam Tools Window. 
 

4. Kemudian pilih clip potongan kedua, lalu klik kanan pada clip potongan kedua tersebut. Maka 

akan tampil pop‐up menu. 

 

5. Selanjutnya pada pop‐up menu tersebut pilih Copy. 

 

6. Selanjutnya klik pada area kosong pada Track Video 1 di sebelah kanan potongan kedua. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 7.44 Tampilan pop-up menu 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.42 Clip yang dipotong tepat ditengah 
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Gambar 7.45 Duplikasi potongan kedua dalam Timeline Window 

 

 

 

 

 

 
Gambar 7.46 Pemilihan clip yang berada di tengah 

7. Kemudian pada menu pilih Edit > Paste. Maka potongan clip kedua akan diduplikasi dan 

tampilan Timeline Window akan tampak seperti pada gambar berikut ini. 

8. Selanjutnya pilih clip yang berada di tengah. 
 

9. Kemudian pada menu pilih Clip > Video Options > Frame Hold. Maka akan tampil kotak 

dialog Frame Hold Options. 

 

10. Selanjutnya aktifkan pilihan Hold On dan pada rollout di sebelahnya pilih In Point (untuk 

mengatur clip diberhentikan pada In Point, pilihan Out Point akan menghentikan clip pada 

posisi Out Point). Aktifkan juga pilihan Deinterlace agar ketika clip diberhentikan tidak akan 

menghasilkan flicker (gambar berkedip). Kemudian tekan OK. Lalu jalankan movie 

menggunakan tombol Play. 

 

 

 

 

 
 

Gambar 7.47 Kotak dialog Frame Hold Options 
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Gambar 7.48 Kotak dialog Clip Speed/Duration 

Reverse Motion 

Manipulasi reverse motion pada prinsipnya adalah membalik nilai dari kecepatan/speed, 

kita dapat melakukan pula melakukan fast reverse motion (adegan balik yang dipercepat) 

atau slow reverse motion (adegan balik yang diperlambat). Berikut ini langkah- 

langkahnya : 

1. Susun sebuah clip ke dalam Timeline Window. 

 

2. Pilih clip tersebut kemudian klik kanan pada clip tersebut sehingga akan tampil pop‐up menu. 

 

3. Pada pop‐up menu pilih Speed/Duration. Maka akan tampil kotak dialog Clip Speed/Duration. 
 

4. Kemudian aktifkan pilihan Reverse Speed untuk membuat reverse motion. Untuk membuat 

fast reverse motion ubah nilai Speed menjadi lebih besar dari 100, sedangkan untuk membuat 

slow reverse motion ubah nilai Speed menjadi kurang dari 100. Pilihan Maintain Audio Pitch 

berfungsi untuk menstabilkan pitch audio ketika terjadi perubahan nilai Speed dan Duration. 

5. Kemudian tekan OK. Jalankan movie dan lihat perubahan yang terjadi. 

 
Menggunakan Rate Stretch Tool 

Selain menggunakan cara-cara diatas, proses manipulasi durasi juga dapat dilakukan 

menggunakan Rate Stretch Tool yang terdapat dalam Tools Window. Dengan 

menggunakan tool ini kita dapat mempercepat dan memperlambat clip langsung di dalam 

Timeline. Berikut ini langkah-langkahnya : 

1. Susun sebuah clip ke dalam Timeline Window. 

 

2. Kemudian klik tombol Rate Stretch Tool yang terdapat di dalam Tools Window. 
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Gambar 7.50 Tampilan clip sebelum diatur durasinya menggunakan Rate Stretch Tool 

 

 

3. Dekatkan kursor pada bagian ujung clip. 
 

4. Kemudian lakukan klik dan drag untuk mengurangi dan menambah kecepatan. Jika kita 

memperpendek clip maka durasi akan menjadi pendek sehingga clip akan dimainkan lebih 

cepat (fast motion). Tetapi apabila clip kita perpanjang maka durasinya akan bertambah 

panjang sehingga clip akan dimainkan lebih lambat (slow motion). 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7.51 Tampilan clip yang diperpendek durasinya (fast motion) 

 
 
 
 
 
 
 
 
 
 
 

Gambar 7.52 Tampilan clip yang diperpanjang durasinya (slow motion) 

 

 
Gambar 7.49 Tombol Rate Stretch Tool 



 

Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 
Gambar 7.53 Prinsip Ripple Edit 

 

 

 

 

 

 

 
Gambar 7.54 Penyusunan 3 buah clip di dalam Timeline Window 

 

 
Gambar 7.55 Tombol Ripple Edit Tool 

Koreksi Durasi Clip dalam Timeline 

Apabila kita telah menyusun banyak clip ke dalam Timeline Window, kemudian ingin 

mengoreksi durasi clip, misalnya memendekkan atau memanjangkan durasi clip yang ada 

di tengah-tengah, tentu saja koreksi durasi pada clip yang berada di tengah akan 

mempengaruhi clip-clip yang ada di sampingnya. Adobe Premiere Pro menyediakan 

berbagai tool untuk melakukan hal ini, yaitu Ripple Edit Tool, Rolling Edit Tool, Slip 

Edit Tool dan Slide Edit Tool. 

 

Ripple Edit 

Pada Ripple Edit durasi clip yang lain yang ada disebelah clip yang diedit durasinya 

adalah tetap/tidak mengalami perubahan, namun keseluruhan durasi akan berubah 

menurut banyaknya perubahan durasi dari clip yang diedit. 

Berikut ini langkah-langkah untuk melakukan Ripple Edit : 
 

1. Susun 3 buah clip ke dalam Timeline Window pada Track Video 1 dengan posisi sedemikian 

rupa, seperti pada gambar di bawah ini. 

2. Kemudian klik tombol Ripple Edit Tool yang ada dalam Tools Window. 
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Gambar 7.58 Prinsip dasar Roll Edit 

 

 

 

 

 

 

 

 

 
Gambar 7.56 Perubahan durasi clip kedua menggunakan Ripple Edit Tool 

3. Selanjutnya dekatkan kursor ke bagian ujung clip pertama. Kemudian klik dan drag maju 

mundur untuk memanjangkan dan memendekkan clip yang berada di tengah/clip kedua. 

4. Maka dalam Sequence Monitor Window akan tampil 2 frame yang menunjukkan Out Point 

clip di sebelah kiri dan In Point clip di sebelah kanan. 

 
 

Rolling Edit 

Pada Rolling Edit, durasi keseluruhan clip akan dipertahankan/tetap, jadi jika clip yang 

berada di tengah dipanjangkan atau dipendekkan maka clip-clip yang berada di 

sebelahnya akan mengalami penyesuaian. 

Berikut ini langkah-langkah untuk melakukan Rolling Edit : 

 

 

 

 

 

 

 

 

 
Gambar 7.57 Tampilan Sequence Monitor Window ketika dilakukan Ripple Edit 
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Gambar 7.59 Tombol Rolling Edit 

 

 

 

 

 

 

 

 

 
Gambar 7.60 Tampilan Rolling Edit dalam Sequence Monitor Window 

1. Susun 3 buah clip ke dalam Timeline Window pada Track Video 1 dengan posisi sedemikian 

rupa, seperti pada gambar di bawah ini. 

2. Kemudian klik tombol Ripple Edit Tool yang ada dalam Tools Window. 
 

3. Selanjutnya dekatkan kursor ke bagian ujung clip pertama. Kemudian klik dan drag maju 

mundur untuk memanjangkan dan memendekkan clip yang berada di tengah/clip kedua. 

Perubahan durasi clip kedua tidak akan merubah durasi keseluruhan clip, clip pertama dan 

ketiga durasinya akan menyesuaikan. 

 

4. Maka dalam Sequence Monitor Window akan tampil 2 frame yang menunjukkan Out Point 

clip di sebelah kiri dan In Point clip di sebelah kanan. 

 

Slip Edit 

Slip Edit digunakan untuk merubah posisi In Point dan Out Point dari clip yang ada di 

tengah, durasi clip yang berada di sebelah (clip pertama dan ketiga) tetap, durasi 

keseluruhan clip juga tidak berubah/tetap. 

 

 

 

 

 

 

 

 
 

Gambar 7.59 Tampilan Rolling Edit dalam Timeline Window 
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Gambar 7.61 Prinsip dasar Slip Edit 

 

 
 

Gambar 7.62 Tombol Slip Edit 

 

 

Untuk melakukan Slip Edit kita menggunakan tombol Slip Edit yang berada di dalam 

Tools Window. 

Kemudian kita dapat melakukan klik dan drag pada clip tengah (clip kedua) untuk 

merubah posisi In Point dan Out Point. Pada perubahan ini durasi clip pertama dan ketiga 

akan tetap, durasi keseluruhan juga tetap. 

 

Pada saat melakukan Slip Edit, Sequence Monitor Window akan menampilkan 2 buah 

frame besar di bawah dan 2 buah frame kecil di sebelah atas (sudut kiri dan sudut kanan). 

Dua buah frame besar di bawah menerangkan bahwa frame sebelah kiri merupakan In 

Point clip kedua dan sebelah kanan merupakan Out Point clip kedua. Sedangkan 2 frame 

yang berada di atas, di sebelah kiri merupakan Out Point clip pertama dan di sebelah 

kanan merupakan In Point clip ketiga. 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.63 Proses Slip Edit dalam Timeline Window 
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Gambar 7.65 Prinsip dasar Slide Edit 

 

 
 

Slide Edit 

Slide Edit digunakan untuk menggeser posisi clip dalam Timeline. Pada pilihan Slide 

Edit, durasi In Point dan Out Point pada clip kedua (tengah) tidak mengalami perubahan, 

durasi keseluruhan clip juga tetap. 

Untuk melakukan Slide Edit kita menggunakan tombol Slide Edit yang berada di dalam 

Tools Window. 

 

Kemudian kita dapat melakukan klik dan drag pada clip tengah (clip kedua) untuk 

merubah posisi clip tersebut. Pada perubahan ini durasi clip pertama dan ketiga akan 

menyesuaikan, durasi keseluruhan clip akan tetap. 

 

 

Gambar 7.66 Tombol Slide Edit 

 

 

 

 

 

 

 

 

 

 
 

Gambar 7.64 Tampilan Sequence Monitor Window pada saat melakukan Slip Edit 
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Gambar 7.68 Tampilan Sequence Monitor Window pada saat melakukan Slide Edit 

 

 

Pada saat melakukan Slide Edit, Sequence Monitor Window akan menampilkan 2 buah 

frame besar di bawah dan 2 buah frame kecil di sebelah atas. Dua buah frame besar di 

bawah menerangkan bahwa frame sebelah kiri merupakan Out Point clip pertama dan 

sebelah kanan merupakan In Point clip ketiga. Sedangkan 2 frame yang berada di atas, di 

sebelah kiri merupakan In Point clip kedua dan di sebelah kanan merupakan Out Point 

clip kedua. 

 

Mengenal Lift dan Extract 

Fasilitas Lift dan Extract digunakan untuk menghapus bagian clip yang ada di dalam 

Timeline Window. Perbedaan dari keduanya adalah Lift akan membiarkan daerah yang 

terhapus tetap kosong, sedangkan Extract akan mengisi bagian yang kosong tersebut 

dengan menggeser bagian sebelah kanan clip yang tidak terpotong. 

 

Menggunakan Lift 

Berikut ini langkah-langkah menggunakan Lift : 

 

 

 

 

 

 

 

 

 

 

 

Gambar 7.67 Proses Slide Edit dalam Timeline Window 
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Gambar 7.69 Susunan clip dalam Timeline Window 

 

 
Gambar 7.72 Tombol Set Out Point 

1. Susun 3 buah clip ke dalam Timeline Window pada Track Video 1 dengan posisi sedemikian 

rupa, seperti pada gambar di bawah ini. 

2. Lalu tentukan waktu awal pemotongan dengan menggeser Current Time Marker. Kemudian 

klik tombol Set In Point yang ada di dalam Sequence Monitor Window untuk menentukan In 

Point. 

 

3. Kemudian geser Current Time Marker untuk menentukan posisi akhir pemotongan. 

Selanjutnya klik tombol Set Out Point yang ada di dalam Sequence Monitor Window. 

 

 
Gambar 7.70 Tombol Set In Point 

 
 
 
 
 
 
 
 
 
 

 
Gambar 7.71 Tampilan Timeline setelah dilakukan Set In Point 
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Gambar 7.74 Tombol Lift 

 

 

 

 

 

 

 

 

 

Gambar 7.75 Pemotongan clip menggunakan Lift 

 

 

4. Kemudian tekan tombol Lift yang berada di dalam Sequence Monitor Window untuk 

melakukan pemotongan. 

5. Maka hasil pemotongan akan tampak dalam Timeline seperti pada gambar di bawah ini. 
 

 

Menggunakan Extract 

Berikut ini langkah-langkah menggunakan Extract : 
 

1. Susun 3 buah clip ke dalam Timeline Window pada Track Video 1 dengan posisi sedemikian 

rupa, seperti pada gambar di bawah ini. 

 

 

 

 

 

 

 

 

 
 

Gambar 7.73 Tampilan Timeline setelah dilakukan Set Out Point 
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Gambar 7.77 Tombol Set In Point 

 
 
 
 
 
 
 
 
 
 

 
Gambar 7.78 Tampilan Timeline setelah dilakukan Set In Point 

 

 

2. Lalu tentukan waktu awal pemotongan dengan menggeser Current Time Marker. Kemudian 

klik tombol Set In Point yang ada di dalam Sequence Monitor Window untuk menentukan In 

Point. 

3. Kemudian geser Current Time Marker untuk menentukan posisi akhir pemotongan. 

Selanjutnya klik tombol Set Out Point yang ada di dalam Sequence Monitor Window. 

 

 

 
Gambar 7.79 Tombol Set Out Point 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 7.80 Tampilan Timeline setelah dilakukan Set Out Point 

 

 

 

 

 

 

 

 
 

Gambar 7.76 Susunan clip dalam Timeline Window 
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Gambar 7.81 Tombol Extract 

 

 

 

 

 

 

 

 

 

 

Gambar 7.82 Pemotongan clip menggunakan Extract 

4. Kemudian tekan tombol Extract yang berada di dalam Sequence Monitor Window untuk 

melakukan pemotongan. 

5. Maka hasil pemotongan akan tampak dalam Timeline seperti pada gambar di bawah ini. 
 

 

 

Three Point Editing dan Four Point Editing Untuk 

Menyisipkan Clip 

Untuk menyisipkan clip ke dalam Timeline Window kita dapat menggunakan kedua 

teknik ini yaitu Three Point Editing dan Four Point Editing. 

 

Three Point Editing 

Teknik ini disebut Three Point karena kita menggunakan tiga titik sebagai referensi 

editing, jadi pertama-tama kita tentukan In Point dan Out Point dari clip yang akan 

disisipkan dalam Source Monitor Window, kemudian kita tentukan In Point atau Out 

Point pada Sequence Monitor Window. Berikut ini langkah-langkah teknik Three Point 

Editing : 

1. Susun 3 buah clip ke dalam Timeline Window pada Track Video 1 dengan posisi sedemikian 

rupa, seperti pada gambar di bawah ini. 
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Gambar 7.84 Tampilan clip yang akan disisipkan di dalam Source Monitor Window 

 

 

2. Kemudian klik dua kali pada salah satu clip yang berada didalam Project Window, clip inilah 

yang nantinya akan disisipkan ke dalam Timeline. 

3. Setelah clip di klik dua kali maka clip tersebut akan ditampilkan di dalam Source Monitor 

Window. 

4. Kemudian tentukan titik In Point dan Out Point menggunakan tombol Set In Point dan Set Out 

Point yang ada dalam Source Monitor Window. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.85 Penentuan titik In Point dan Out Point di dalam Source Monitor Window 

 

 

 

 

 

 

 
Gambar 7.83 Susunan clip dalam Timeline Window 
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Gambar 7.86 Penentuan posisi In Point dalam Timeline Window 

 

 
Gambar 7.89 Tombol Overlay 

 
 
 
 
 
 
 
 
 
 

 
Gambar 7.90 Tampilan penggunaan Overlay untuk menyisipkan clip ke dalam Timeline 

5. Selanjutnya geser Current Time Marker ke lokasi tempat clip akan disisipkan. Lalu klik tombol 

Set In Point yang berada dalam Sequence Monitor Window untuk menentukan In Point. 

6. Selanjutnya kita dapat menggunakan tombol Insert yang ada di dalam Source Monitor 

Window untuk menyisipkan clip ke dalam Timeline. 

 

7. Atau dapat pula menggunakan tombol Overlay yang berada dalam Source Monitor Window 

untuk menyisipkan clip ke dalam Timeline. 

 

 
Gambar 7.87 Tombol Insert 

 
 
 
 
 
 
 
 
 

 
Gambar 7.88 Tampilan penggunaan Insert untuk menyisipkan clip ke dalam Timeline 
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Gambar 7.91 Susunan clip dalam Timeline Window 

Perbedaan dasar antara Insert dan Overlay adalah, Insert akan menyisipkan clip dengan 

mengubah panjang durasi keseluruhan clip menjadi bertambah panjang, sedangkan 

Overlay akan menyisipkan clip tanpa merubah durasi keseluruhan clip, tetapi mengambil 

porsi durasi dari clip yang ada disebelahnya. 

 

Four Point Editing 

Jika dalam teknik Three Point Editing kita gunakan 3 buah titik sebagai referensi, maka 

pada teknik Four Point Editing akan dipergunakan 4 titik sebagai referensi. Jadi pertama 

kita tentukan In Point dan Out Point clip yang akan disisipkan di dalam Source Monitor 

Window, kemudian setelah itu kita tentukan In Point dan Out Point dalam Sequence 

Monitor Window. Berikut ini langkah-langkah menggunakan Four Point Editing : 

1. Susun 3 buah clip ke dalam Timeline Window pada Track Video 1. 
 

2. Kemudian klik dua kali pada salah satu clip yang berada didalam Project Window, clip inilah 

yang nantinya akan disisipkan ke dalam Timeline. Maka clip tersebut akan tampil di dalam 

Source Monitor Window. 

3. Kemudian tentukan In Point dan Out Point pada clip yang berada di dalam Source Monitor 

Window menggunakan tombol Set In Point dan Set Out Point. 
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Gambar 7.93 Penentuan titik In Point dan Out Point di dalam Timeline Window 

 

 
Gambar 7.94 Tombol Insert 

 

 

4. Lalu geser Current Time Marker untuk menentukan posisi In Point dalam Timeline. Setelah itu 

klik tombol Set In Point yang ada di dalam Sequence Monitor Window. 

5. Kemudian geser Current Time Marker untuk menentukan posisi Out Point dalam Timeline. 

Selanjutnya klik tombol Set Out Point yang berada di dalam Sequence Monitor Window. 

6. Selanjutnya klik tombol Insert yang berada di dalam Source Monitor Window. 
 

7. Karena clip yang akan disisipkan memiliki durasi yang lebih panjang dari area dalam Timeline 

Window, maka akan tampil kotak dialog Fit Clip yang menawarkan 5 solusi. Lalu pilih salah 

satu solusi dalam Option, kemudian tekan OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 7.92 Penentuan titik In Point dan Out Point di dalam Source Monitor Window 
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Gambar 7.96 Tampilan pilihan Change Clip Speed dalam Timeline 

 

 

8. Jika pilihan Change Clip Speed dipilih maka clip akan di sesuaikan durasinya (di‐stretch) 

untuk memenuhi area yang kosong. 

9. Jika pilihan Trim Clip’s Head dipilih maka clip yang disisipkan akan di trimming dari sisi 

kiri/depan sesuai dengan durasi area yang kosong. 

 

10. Jika pilihan Trim Clip’s Tail dipilih maka clip yang disisipkan akan di trimming dari sisi 

kanan/belakang sesuai dengan durasi area yang kosong. 

 

 

 

 

 

 

 
 

Gambar 7.97 Tampilan pilihan Trim Clip’s Head dalam Timeline 

 

 

 

 

 

 

 

 

 

 
Gambar 7.95 Kotak dialog Fit Clip 
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Gambar 7.98 Tampilan pilihan Ignore Sequence In Point dalam Timeline 

 

 

11. Jika pilihan Ignore Sequence In Point dipilih maka clip akan disisipkan pada bagian awal 

Timeline atau posisi 00:00:00:00 kemudian clip tersebut akan di trimming sampai posisi Out 

Point dalam Timeline Window. 

12. Jika pilihan Ignore Sequence Out Point dipilih maka clip akan disisipkan pada titik In Point 

dalam Timeline, kemudian durasi clip yang disisipkan tidak mengalami perubahan durasi dan 

mengisi area kosong dengan mendorong clip yng ada di sebelahnya sehingga mempengaruhi 

dirasi keseluruhan clip (menjadi lebih panjang). 

 
 

Unlink Video dan Audio 

Video hasil capture biasanya disertai audio/suara. Apabila disusun dalam Timeline 

Window maka clip tersebut akan menempatkan format video ke dalam Track Video dan 

format audio ke dalam Track Audio. Biasanya clip tersebut berwarna hijau. Jika clip 

 

 

 

 

 

 

 

Gambar 7.99 Tampilan pilihan Ignore Sequence Out Point dalam Timeline 

 

 

 

 

 

 

 
 

Gambar 7.97 Tampilan pilihan Trim Clip’s Tail dalam Timeline 
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Gambar 7.100 Susunan clip dalam Timeline 

 

 

 

 

 

 

 

 

 
Gambar 7.101 Pemindahan posisi clip pada Track Audio tidak mempengaruhi clip yang ada dalam Track Video 

dipindah atau digeser maka Track Video dan Track Audio akan ikut berpindah pada 

posisi yang sama. 

Berikut ini langkah-langkah untuk memisahkan (unlink) format video dan format audio 

dari clip video : 

1. Susun clip video hasil capture ke dalam Timeline Window. 
 

2. Lalu pilih clip tersebut, kemudian pada menu pilih Clip > Unlink Audio and Video. 

 

3. Setelah itu coba pindahkan/geser clip yang berada di Track Audio ke sebelah kanan. 

 

4. Maka clip yang berada di Track Video tidak akan ikut berpindah/bergeser. 
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BAB 8 

 ANIMASI CLIP/MOTION 

GRAPHICS 
 

 

 

 

 
 



 

Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 8.1 Tampilan clip dvindonesia.psd 

Adobe Premiere Pro memiliki fasilitas animasi yang baru dibandingkan dengan Adobe 

Premiere versi sebelumnya. Animasi dalam Adobe Premiere sebenarnya adalah membuat 

perubahan nilai yang dinamis pada property yang ada, tetapi hanya property yang 

memiliki tombol time vary (stopwatch) saja yang dapat dianimasikan. Fasilitas animasi 

yang baru ini menjanjikan kemudahan dalam melakukan proses animasi (animasi 

position, animasi scale, animasi rotation, dan animasi anchor point) menggunakan metode 

keyframing. 

 

Animasi Position 

Animasi position disebut juga animasi perpindahan posisi, pada latihan ini kita akan 

membuat animasi perpindahan posisi clip dari posisi kiri kemudian bergeser ke arah 

kanan. 

 

Persiapan Latihan 

Dalam latihan kali ini kita akan menggunakan clip dvindonesia.psd yang memiliki Alpha 

Channel. Clip ini berukuran 720 x 576 pixel, dan dibuat menggunakan Adobe Photoshop 

CS dengan latar belakang transparan. 

 

 
 

Latihan Animasi Position 

Berikut ini langkah-langkah latihan membuat animasi position : 
 

1. Import clip dvindonesia.psd, caranya pilih File > Import. 
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Gambar 8.2 Kotak dialog Import 

 

 

 

 

 

 

 

 
Gambar 8.3 Kotak dialog Import Layered File 

2. Maka akan tampil kotak dialog Import. 
 

3. Lalu pilih file dvindonesia.psd, kemudian tekan Open. 

 

4. Maka akan tampil kotak dialog Import Layered File, biarkan pada pilihan default. Kemudian 

tekan OK. 

5. Maka clip dvindonesia akan tampil dalam Project Window. 

 

6. Selanjutnya drag salah satu clip yang ada dalam Project Window ke dalam Timeline Window, 

letakkan pada Track Video 1 karena clip ini nantinya akan berfungsi sebagai clip background. 
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Gambar 8.5 Clip dvindonesia.psd yang diletakkan pada Track Video 2 

 

 

7. Lalu susun clip dvindonesia.psd pada Timeline Window, letakkan pada Track Video 2 untuk 

melakukan superimpose. 

8. Karena clip dvindonesia.psd memiliki Alpha Channel maka tampilan pada Sequence Monitor 

Window akan tampak seperti pada gambar di bawah ini. 

 

9. Pastikan clip dvindonesia.psd dalam keadaan terpilih atau aktif. 

 

10. Geser posisi Current Time Marker ke posisi waktu awal clip atau 00:00:00:00. 

 

 

 

 

 

 

 

 

 
Gambar 8.6 Tampilan movie dalam Sequence Monitor Window 

 

 

 

 

 

 

 

 

 
 

Gambar 8.4 Clip video backgroud yang diletakkan pada Track Video 1 
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Gambar 8.8 Tab Effect Control pada clip dvindonesia.psd 

 

 
Gambar 8.9 Tombol Toggle Animation 

 

 

 

 

 

 

 

 

 

 

Gambar 8.10 Perubahan nilai pada property Position 

 

 

11. Kemudian expand pilihan Motion yang ada dalam Tab Effect Controls. 
 

12. Berikutnya klik tombol Toggle Animation untuk memulai proses keyframe. 
 

13. Selanjutnya ubah nilai property Position menjadi ‐180 , 288. 
 

 

 

 

 

 

 

 

 

 

Gambar 8.7 Current Time Marker pada posisi waktu 00:00:00:00 
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Gambar 8.11 Penggeseran Current Time Marker ke posisi waktu 00:00:16:00. 

 

 

 

 

 

 

 

 

 

Gambar 8.12 Perubahan nilai property Position 

 

 

 

 

 

 

 

 
Gambar 8.13 Tampilan movie dalam Sequence Monitor Window 

14. Kemudian geser Current Time Marker ke posisi waktu 00:00:16:00. 
 

15. Lalu ubah nilai property Position menjadi 360,288. 
 

16. Maka tampilan movie akan tampak seperti pada gambar berikut. 
 

17. Kemudian geser Current Time Marker ke posisi waktu 00:00:45:00. 
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Gambar 7.45 Tombol Add/Remove Keyframe 

 
 
 
 
 
 
 
 
 
 

Gambar 8.15 Penambahan keyframe 

 

 

 

 

 

 

 

 

 

 
Gambar 8.16 Penggeseran Current Time Marker ke posisi waktu 0:01:01:00 

 

 

 
Gambar 8.17 Perubahan nilai property Position 

 

 

18. Lalu klik tombol Add/Remove Keyframe untuk membuat sebuah keyframe. 
 

19. Kemudian geser Current Time Marker ke posisi waktu akhir movie atau 00:01:01:00. 
 

20. Selanjutnya ubah nilai property Motion menjadi 910,288. 
 

 

 

 

 

 

 

 

 

 

 
Gambar 8.14 Penggeseran Current Time Marker ke posisi waktu 00:00:45:00 
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Gambar 8.18 Tampilan movie pada posisi waktu 00:01:01:00 

 

 

 

 

 

 

 

 

 

 
Gambar 8.19 Susunan clip dalam Timeline Window 

21. Maka tampilan movie pada posisi waktu 00:01:01:00 akan tampak seperti pada gambar berikut. 
 

22. Jalankan movie, maka akan terlihat perpindahan posisi dari sebelah kiri menuju ke sebelah 

kanan. 

 

Animasi Rotation 

Property Rotation dalam Tab Effect Controls juga dapat dianimasikan karena memiliki 

tombol stopwatch. Berikut ini langkah-langkahnya : 

1. Susun sebuah clip yang akan dijadikan sebagai background ke dalam Timeline Window pada 

Track Video 1. 

2. Kemudian susun clip dvindonesia.psd ke dalam Timeline Window letakkan pada Track Video 

2. Lalu atur durasinya sedemikian rupa. 
 

3. Lalu geser Current Time Marker ke posisi awal clip atau 00:00:00:00. 

 

4. Lalu pilih clip dvindonesia.psd sehingga Tab Effect Controls akan menampilkan property clip 

tersebut. Lalu pada Tab Effect Controls expand pilihan Motion. 
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Gambar 8.20 Tampilan Toggle Animation 

 
 

 
Gambar 8.21 Perubahan nilai pada Rotation 

 

 

 

 

 

 

 

 

 

 

Gambar 8.23 Penggeseran Current Time Marker ke posisi akhir clip 

 

 
Gambar 8.24 Perubahan nilai Rotation pada 00:00:51:19 

5. Kemudian pada pilihan Rotation klik tombol time‐vary (Toggle Animation) untuk memulai 

keyframing. Kemudian ubah nilai Rotation menjadi 0 X ‐180°. Maka akan tercipta sebuah 

keyframe. 

6. Maka tampilan pada Sequence Monitor Window akan tampak seperti pada gambar di bawah 

ini. 

 

7. Kemudian geser Current Time Marker ke posisi akhir clip, atau posisi waktu 00:00:51:19. 
 

8. Selanjutnya ubah nilai Rotation pada Tab Effect Controls menjadi 0 X 359.9°. 
 

 

 

 

 

 

 

 

 

 
Gambar 8.22 Tampilan perubahan nilai Rotation 
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Gambar 8.25 Tampilan Sequence Monitor Window pada posisi waktu 00:00:51:19 

 

 

 

 

 

 

 

 

 

 

Gambar 8.26 Penyusunan clip dalam Timeline Window 

9. Sehingga tampilan dalam Sequence Monitor Window akan tampak seperti ini. 
 

10. Maka jika movie di‐Play akan terlihat animasi rotasi logo DVIndonesia. 

 

Animasi Scale 

Pada latihan ini kita akan mencoba membuat animasi perbesaran menggunakan property 

Scale, berikut ini langkah-langkahnya : 

1. Susun sebuah clip yang akan dijadikan sebagai background ke dalam Timeline Window pada 

Track Video 1. 

2. Kemudian susun clip dvindonesia.psd ke dalam Timeline Window letakkan pada Track Video 

2. Lalu atur durasinya sedemikian rupa. Jangan lupa geser posisi Current Time Marker ke 

posisi waktu 00:00:00:00. 
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Gambar 8.28 Tampilan Toggle Animation 

 

 
Gambar 8.29 Perubahan nilai Scale 

 

 

 

 

 

 

 

 

 
Gambar 8.30 Tampilan perubahan nilai Scale 

 

 

3. Lalu pilih clip dvindonesia.psd sehingga Tab Effect Controls membuka. Selanjutnya expand 

property Motion. 

4. Lalu klik tombol time‐vary atau Toggle Animation. 
 

5. Kemudian pada posisi waktu 00:00:00:00 ubah nilai Scale menjadi 50. 
 

6. Maka tampilan Sequence Monitor Window akan tampak seperti pada gambar di bawah ini. 
 

7. Kemudian geser Current Time Marker ke posisi akhir clip atau pada posisi waktu 00:00:52:01. 

 

 

 

 

 

 

 

 

 
Gambar 8.27 Tampilan awal Sequence Monitor Window pada posisi waktu 00:00:00:00 
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Gambar 8.32 Perubahan nilai pada property Scale 

 

 

Gambar 8.34 Tampilan keyframe sebelum dimodifikasi 

 

 

8. Selanjutnya ubah nilai Scale pada Tab Effect Controls menjadi 150. 
 

9. Maka tampilan pada Sequence Monitor Window akan tampak seperti pada gambar 

berikutnya. 

 

10. Kemudian jalankan movie, maka akan terlihat animasi perbesaran logo DVIndonesia. 

 

Memodifikasi Keyframe Animasi 

Apabila terjadi kesalahan, kita dapat melakukan koreksi terhadap keyframe. Keyframe 

yang telah dibuat dapat digeser kekanan dan kekiri untuk mengatur durasi sesuai dengan 

keinginan kita. 

 

 

 

 

 

 

 

 

 
Gambar 8.33 Tampilan perubahan nilai Scale 

 

 

 

 

 

 

 

 

 

 

 
Gambar 8.31 Penggeseran Current Time Marker ke posisi waktu 00:00:52:01 
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Untuk menghapus salah satu keyframe caranya pilih keyframe yang akan dihapus, 

kemudian setelah terpilih tekan Delete pada keyboard. Sedangkan untuk menghapus 

semua keyframe yang ada caranya klik tombol time-vary atau Toggle Animation yang 

aktif maka semua keyframe akan terhapus. 

 

 

Gambar 8.35 Penggeseran letak keyframe untuk merubah durasi 
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BAB 9 

 MEMBUAT TITLE 
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Gambar 9.1 Sebuah clip yang disusun dalam Track Video 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.2 Adobe Title Designer 

Adobe Premiere Pro menyediakan fasilitas untuk membuat title menggunakan tool Adobe 

Title Designer. Adobe Title Designer merupakan fasilitas titling standar yang memiliki 

banyak tool dan template yang bisa kita gunakan untuk membuat title dan logo sesuai 

dengan ide kreatif kita. 

 

Mulai Membuat Title 

Untuk membuat title menggunakan Adobe Title Designer berikut ini langkah-langkahnya 

: 
 

1. Susun sebuah clip ke dalam Timeline Window lalu tempatkan pada Track Video 1, klip inilah 

yang nantinya akan digunakan sebagai background title. 

2. Lalu pada menu pilih File > New > Title. Maka akan tampil window Adobe Title Designer. 
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Gambar 9.3 Tombol Type Tool 

 

 

 

 

 

 

 

 

 
 

Gambar 9.4 Penggunaan Type Tool di dalam Monitor 

 

 

 

 

 
Gambar 9.5 Perubahan nilai Font Size 

 

 

 

 

 

 

 

 

 
 

Gambar 9.6 Tampilan perubahan Font Size pada Monitor 

3. Kemudian pastikan tombol Type Tool terpilih. Tombol Type Tool berada pada kumpulan 

tombol Tool di sebelah kiri window. 

4. Setelah itu ketikkan kalimat “Nasib Pejalan Kaki” di dalam Monitor. 
 

5. Kemudian ubah nilai Font Size yang ada dalam pilihan Object Style menjadi 120. 
 

6. Sehingga tampilan pada Monitor akan tampak seperti ini. 
 

7. Lalu kita dapat mengatur letak text yang telah kita buat menggunakan tombol Selection Tool. 

Selanjutnya drag ke posisi yang kita inginkan. 
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Gambar 9.8 Kotak dialog yang menawarkan penyimpanan file 

 

 

8. Kemudian tutup window Adobe Title Designer menggunakan tombol silang yang ada di 

sudut kanan atas window. 

9. Maka akan muncul kotak dialog yang menanyakan apakah kita akan menyimpan file title 

sebelum kita menutup window. Untuk menyimpan tekan Yes. 

10. Kemudian akan tampil kotak dialog Save Title, kemudian isi File name dengan nama “NASIB”. 

Selanjutnya tekan Save, maka file title akan disimpan dalam format *.prtl. 

 

11. Maka nama file title “NASIB” akan tampil dalam Project Window. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 9.9 Kotak dialog Save Title 

 

 
Gambar 9.7 Tombol Selection Tool 
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Gambar 9.11 Susunan clip dalam Timeline Window 

 

 

12. Lalu susun title NASIB ke dalam Timeline Window, letakkan pada Track Video 2. 
 

13. Maka tampilan pemberian title dalam Sequence Monitor Window akan tampak seperti pada 

gambar berikut. 

 

Langkah-langkah diatas merupakan langkah dasar pengaplikasian title di dalam project 

digital video kita. Masih terdapat banyak pengaturan property agar title yang kita buat 

terlihat bagus. 

 

 

 

 

 

 

 

 

Gambar 9.12 Tampilan title di dalam Sequence Monitor Window 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.10 Title NASIB yang berada dalam Project Window 
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Gambar 9.13 Tombol Vertical Type Tool 

 

 

 

 

 

 

 

 
 

Gambar 9.14 Tampilan Vertical Type Tool 

 

 
Gambar 9.15 Tombol Area Type Tool 

Membuat Text Vertikal 

Untuk membuat text vertikal kita dapat menggunakan tombol Vertical Type Tool, berikut 

ini langkah-langkahnya : 

1. Klik tombol Vertical Type Tool yang berada di sebelah kiri window Adobe Title Designer. 
 

2. Lalu ketikkan text di dalam Monitor. 
 

 

Membuat Text Paragraf Horisontal 

Untuk membuat text paragraf horisontal kita dapat menggunakan tombol Area Type  

Tool, berikut ini langkah-langkahnya : 

1. Klik tombol Area Type Tool yang berada di sebelah kiri window Adobe Title Designer. 
 

2. Kemudian buat area paragraf pada Monitor dengan cara drag dan klik dari area kiri atas ke 

kanan bawah. 
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Gambar 9.17 Tampilan paragraf horisontal menggunakan Area Type Tool 

 

 
Gambar 9.18 Tombol Vertical Area Type Tool 

 

 

3. Kemudian ketikkan text di dalam area paragraf tersebut. 
 

 

Membuat Text Paragraf Vertikal 

Untuk membuat text paragraf vertikal kita dapat menggunakan tombol Vertical Area 

Type Tool, berikut ini langkahnya : 

1. Klik tombol Area Type Tool yang berada di sebelah kiri window Adobe Title Designer. 
 

2. Kemudian buat area paragraf pada Monitor dengan cara drag dan klik dari area kiri atas ke 

kanan bawah. 

3. Setelah itu ketikkan text di dalam area paragraf tersebut. 

 

 

 

 

 

 

 

 

 
Gambar 9.16 Tampilan area paragraf di dalam Monitor 
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Gambar 9.20 Tombol Path Type Tool 

 

 

 

 

 

 

 

 

 
Gambar 9.21 Pembuatan path dalam Monitor 

 

 
 

Membuat Path Text 

Untuk membuat path text kita dapat menggunakan tombol Path Type Tool, berikut ini 

langkahnya : 

1. Klik tombol Path Type Tool yang berada di sebelah kiri window Adobe Title Designer. 
 

2. Kemudian buat path dari kiri ke kanan Monitor dengan cara klik ke dalam Monitor. 
 

3. Setelah itu ketikkan text di dalam path tersebut. 

 

 

 

 

 

 

 

 

 
Gambar 9.19 Tampilan paragraf vertikal menggunakan Vertical Area Type Tool 
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Gambar 9.23 Tombol Vertical Path Type Tool 

 

 

 

 

 

 

 

 

 
Gambar 9.24 Pembuatan path dalam Monitor 

 

 

 
 

Membuat Vertical Path Text 

Untuk membuat path text kita dapat menggunakan tombol Vertical Path Type Tool, 

berikut ini langkahnya : 

1. Klik tombol Vertical Path Type Tool yang berada di sebelah kiri window Adobe Title Designer. 
 

2. Selanjutnya buat path dari atas ke bawah di dalam Monitor. 
 

3. Setelah itu ketikkan text di dalam path tersebut. 

 

 

 

 

 

 

 

 

 

Gambar 9.22 Tampilan Path Text 
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Gambar 9.26 Merubah jenis dan ukuran font 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.27 Perubahan jenis dan ukuran font 

 

 
 

Merubah Jenis dan Ukuran Huruf 

Untuk merubah jenis font maka kita dapat merubah pilihan Font yang ada dalam rollout 

Properties. Sedangkan untuk merubah ukuran font dilakukan dengan merubah nilai pada 

pilihan Font Size. 

 

Memberi Garis Bawah 

Garis bawah atau underline dapat juga diaplikasikan pada title yang kita buat, caranya 

aktifkan pilihan Underline yang ada di dalam rollout Properties dalam Object Style. 

 

 

 

 

 

 

 

 

 

Gambar 9.25 Tampilan Vertical Path Text 
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Gambar 9.30 Merubah warna huruf 

 

 
 

 
 

Merubah Warna Huruf 

Untuk merubah warna huruf/font caranya : 
 

1. Aktifkan Fill kemudian pada Fill Type pilih Solid. 

 

2. Kemudian pilih warna huruf dengan pilihan Color 

 

3. Untuk mengatur transparansi warna huruf gunakan pilihan Opacity. 
 

 

 

 

 

 
 

Gambar 9.28 Aktifasi pilihan Underline 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.29 Tampilan underline di dalam Monitor 



Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

 

Gambar 9.32 Pengaturan Linear Gradient 

 

 

 

 

 

 

 

 

 

 
 

Gambar 9.33 Tampilan title berwarna gradient pada Monitor 

 

 
 

Warna Huruf Gradient 

Selain warna solid kita dapat pula membuat warna gradient untuk diaplikasikan pada 

huruf title, caranya : 

1. Pada rollout Fill dalam Object Style ubah property Fill Type menjadi Linear Gradient. 

 

2. Lalu ubah Color Stop Color dengan warna pilihan kita. Maka akan dihasilkan title dengan 

warna gradient linear. 

 

 

 

 

 

 

 

 

 

 
Gambar 9.31 Tampilan perubahan warna huruf pada Monitor 
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Gambar 9.34 Pengaplikasian Inner Strokes 

Memberikan Stroke 

Kita dapat pula memberikan warna tepi/stroke pada title yang kita buat. Adobe Title 

Designer menyediakan dua mode Stroke yaitu Inner Strokes dan Outer Strokes. Inner 

Strokes akan memberikan garis tepi pada sebelah dalam text, sedangkan Outer Strokes 

akan memberi garis tepi pada area luar text. 

Untuk mengaplikasikan Inner Stroke caranya : 
 

1. Dalam Object Style pada pilihan Strokes, tekan tulisan Add yang ada di sebelah kanan Inner 

Strokes. 

2. Kemudian expand property Inner Strokes sehingga tampil property Inner. 
 

3. Lalu kita dapat mengatur ketebalan Inner Stroke melalui property Size. Lalu ubah nilai Size 

menjadi 30. 

 

4. Maka setelah diaplikasikan Inner Strokes dan diatur ketebalan stroke‐nya, tampilan Monitor 

akan menjadi seperti gambar berikut. 

 

 

 

 

 

 

 

 

 
 

Gambar 9.35 Pengaturan ketebalan Inner Stroke 
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Gambar 9.37 Pengaturan ketebalan Outer Strokes menjadi 50 

 

 

Sedangkan untuk mengaplikasikan Outer Stroke caranya : 
 

1. Klik tulisan Add yang ada di sebelah kanan Outer Strokes. 

 

2. kemudian expand pilihan Outer Strokes. Maka akan tampil property Outer. 

 

3. Untuk mengatur ketebalan Outer Strokes gunakan property Size. Isikan nilai Size sebesar 50. 
 

4. Maka setelah diaplikasikan Outer Strokes dan diatur ketebalan stroke‐nya, tampilan Monitor 

akan menjadi seperti gambar berikut. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.38 Tampilan title yang diberi Inner Strokes dengan nilai Size = 50 pada Monitor 

 

 

 

 

 

 

 

 

 

 
Gambar 9.36 Tampilan title yang diberi Inner Strokes pada Monitor 
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Gambar 9.39 Pembuatan stroke kedua dan pengaturan Size pada stroke kedua 

 

 

 
 

Gambar 9.40 Tampilan pembuatan stroke ganda pada Monitor 

Membuat Stroke Ganda 

Kita dapat mengaplikasikan lebih dari satu stroke ke dalam title yang kita buat. Pada 

latihan kali ini kita akan mengaplikasikan stroke ganda pada Outer Strokes, tetapi kita 

harus membuat sebuah stroke terlebih dahulu. Untuk menambahkan sebuah stroke pada 

Outer Strokes caranya : 

1. Klik tulisan Add yang berada di sebelah kanan Outer Strokes. 

 

2. Maka akan tercipta sebuah property Outer kedua yang terletak di bawah Outer pertama. 
 

3. Kemudian pada pilihan Outer kedua atur property Size menjadi 50. 
 

 

Menghapus Stroke 

Suatu saat mungkin kita mengalami kesalahan dalam mengaplikasikan stroke lalu kita 

ingin menghapus stroke yang telah kita buat. Caranya : 

1. Pilih salah satu Outer yang akan dihapus pada pilihan Inner Strokes atau Outer Strokes. 
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Gambar 9.42 Tampilan pop-up menu 

 

 

 

 

 

 

 

 

Gambar 9.43 Aktifasi Shadow dan property yang dimilikinya 

 

 

2. Kemudian klik tombol panah di sebelah kanan Object Style sehingga tampil pop‐up menu. 

Dalam pop‐up menu tersebut pilih Delete Stroke. Maka stroke akan terhapus. 

 

Memberi Shadow 

Untuk memberi efek bayangan/shadow pada title yang kita buat caranya aktifkan pilihan 

Shadow pada Object Style. Untuk melihat property yang dimiliki Shadow kita dapat 

melakukan expand kemudian kita dapat mengatur property yang ada di dalamnya. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 9.41 Tampilan stroke yang terpilih 
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Gambar 9.45 Tampilan Transform 

 

 
 

Mengatur Property Huruf Menggunakan Transform 

Untuk mengatur property huruf seperti Opacity/transparansi, letak huruf (posisi X dan 

posisi Y), lebar huruf, tinggi huruf, serta rotasinya kita dapat menggunakan Transform. 

Berikut ini fungsi property yang terdapat dalam Transform : 

 Opacity, berfungsi mengatur transparansi huruf. 

 

 X Position, berfungsi mengatur letak huruf berdasar koordinat X. 

 

 Y Position, berfungsi mengatur letak huruf berdasar koordinat Y. 

 

 Width, berfungsi mengatur lebar huruf. 

 

 Height, berfungsi mengatur tinggi huruf. 

 

 Rotation, berfungsi mengatur rotasi/perputaran huruf. 
 

 

Memanfaatkan Styles 

Untuk membuat title yang bagus, selain mengatur secara manual satu persatu property 

yang dimiliki text, kita dapat pula memanfaatkan style yang disediakan Adobe Title 

Designer untuk membuat text yang bagus secara instant. Caranya : 

1. Ketik text di dalam Monitor menggunakan Type Tool. 

 

 

 

 
Gambar 9.44 Tampilan efek Shadow 
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Gambar 9.47 Berbagai pilihan style text dalam Styles 

 

 

 

 
Gambar 9.48 Tampilan text setelah diaplikasikan Styles 

 

 
Gambar 9.49 Tombol Templates 

 

 

2. Pilih pada text tersebut, kemudian klik dua kali pada salah satu pilihan style yang berada di 

dalam Styles. 

3. Maka tampilan title dalam Monitor akan mengalami perubahan. 
 

 

Menggunakan Template 

Adobe Title Designer menyediakan banyak template yang dapat kita gunakan untuk 

membuat title yang bagus secara instant. Untuk menggunakan template caranya : 

1. Klik tombol Templates yang berada pada sebelah atas window Adobe Title Designer. 
 

2. Maka akan tampil kotak dialog Templates. Expand salah satu pilihan template yang ada. 

 

 

 

 

 
Gambar 9.46 Tampilan text sebelum diaplikasikan Styles 
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Gambar 9.51 Tampilan pengaplikasian template 

 

 

 

 

 

 

 

 

 

 
 

Gambar 9.52 Tampilan perubahan text 

 

 

3. Kemudian tekan Apply untuk mengaplikasikan template ke title. 

 

4. Maka tampilannya akan tampak seperti pada gambar di bawah ini. 
 

5. Selanjutnya kita dapat melakukan perubahan pada text yang ada menggunakan Type Tool. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.50 Kotak dialog Templates 
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Gambar 9.53 Nama title di dalam Project Window 

 

 

 

 

 

 

 

 

Gambar 9.54 Susunan clip di dalam Timeline Window 

Mengedit Title 

Pada suatu saat mungkin kita merasa perlu untuk mengedit title yang telah kita buat, 

untuk melakukan edit pada title yang sudah jadi caranya klik dua kali pada nama title 

yang terdapat di dalam Project Window, maka akan tampil window Adobe Title 

Designer. Kemudian kita dapat melakukan perubahan-perubahan menggunakan Adobe 

Title Designer. 

 

Membuat Credit Title 

Seringkali kita melihat di televisi ataupun film, pada saat berakhirnya tayangan terdapat 

text berjalan yang menampilkan nama-nama pemeran/artis dan kru yang terlibat dalam 

pembuatan tayangan tersebut, text inilah yang dinamakan credit title. Untuk membuat 

credit title caranya : 

1. Susun sebuah clip ke dalam Timeline Window lalu tempatkan pada Track Video 1, klip inilah 

yang nantinya akan digunakan sebagai background title. 
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Gambar 9.55 Perubahan pilihan Title Type 

 

 

 

 

 

 

 

 

 

 

 

Gambar 9.57 Pengaturan letak text menggunakan Selection Tool 

2. Lalu pada menu pilih File > New > Title. Maka akan tampil window Adobe Title Designer. 

 

3. Kemudian ubah Title Type menjadi Roll. 
 

4. Selanjutnya ketik text di dalam Monitor menggunakan Type Tool lalu atur property text 

menggunakan Object Style. 

 

5. Kemudian dengan menggunakan Selection Tool atur letak text menjadi agak kebawah. 
 

6. Kemudian tutup jendela Adobe Title Designer. Jangan lupa melakukan penyimpanan pada 

title yang baru saja dibuat dengan nama CREDIT. 

7. Maka nama title CREDIT akan tampil pada Project Window. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.56 Pengetikan text di dalam Monitor 
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Gambar 9.59 Susunan clip dalam Timeline 

 

 

8. Lalu susun title CREDIT ke dalam Timeline Window letakkan pada Track Video 2. 
 

9. Maka tampilan dalam Sequence Monitor Window akan tampak seperti pada gambar di bawah 

ini. 

 

10. Kita dapat melakukan koreksi durasi pada credit title menggunakan tool Ripple Edit, tetapi hal 

ini akan berpengaruh pada durasi dan speed. 

 

 

 

 

 

 

 

 

 
Gambar 9.60 Tampilan Credit Title 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 9.58 Title CREDIT yang ada dalam Project Window 
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Gambar 9.61 Tampilan tool geometri 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 9.62 Tampilan logo sederhana yang dibuat menggunakan tool geometri 

Membuat Logo 

Selain membuat title berupa text, Adobe Title Designer juga dapat digunakan untuk 

membuat title yang berupa bentuk geometri. Dengan bentuk geometri yang disediakan 

lalu digabung dengan text kita maka dapat menyusunnya untuk membuat logo. 

Dalam kumpulan tool geometri tersedia Rectangle Tool, Rounded Corner  Rectangle 

Tool, Clipped Corner Rectangle Tool, Rounded Rectangle Tool, Wedge Tool, Arc Tool, 

Ellipse Tool dan Line Tool. 

 

Memasukkan Gambar 

Image atau gambar dapat pula kita masukkan ke dalam title yang kita buat caranya : 
 

1. Klik kanan pada Monitor di dalam Adobe Title Designer, kemudian akan tampil pop‐up menu. 

 

2. Dalam pop‐up menu pada pilihan Logo pilih Insert Logo. 
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Gambar 9.64 Kotak dialog Imprt Image as Logo 

 

 

 

 

 

 

 

 

 

 
 

Gambar 9.65 Tampilan gambar yang diimpor sebagai logo dalam Monitor 

 

 

3. Maka akan tampil kotak dialog Import Image as Logo. Pilih salah satu file yang ada. Kemudian 

tekan Open. 

4. Maka image/gambar akan diimpor dan ditampilkan dalam Monitor. 
 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 9.63 Tampilan pop-up menu pada Monitor 
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Gambar 9.66 Pengaturan property gambar pada Object Style 

5. Kemudian kita dapat mengatur property gambar dalam Object Style, lalu tambahkan text 

menggunakan Type Tool. 

6. Maka tampilan logo/gambar setelah di tambahkan text akan tampak seperti pada gambar di 

bawah ini. 

 

7. Lalu tutup window Adobe Title Designer, jangan lupa untuk menyimpan title. Simpan dengan 

nama BUNGA. 

 

Animasi Logo 

Pada latihan ini kita akan mencoba menganimasikan title logo yang telah kita buat, 

caranya : 

1. Susun clip background ke pada Track Video 1 dalam Timeline 

 

 

 

 

 

 

 

 

 

 
 

Gambar 9.67 Tampilan logo yang ditambahkan text dalam Monitor 
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Gambar 9.68 Susunan clip dalam Timeline 

 

 

 

 

 

 

 

 

 
Gambar 9.69 Tampilan Sequence Monitor Window 

 

 

 

 

 

 

 

 

 
Gambar 9.70 Tampilan Sequence Monitor Window pada posisi 00:00:00:00 

2. Susun clip title yang berupa logo pada Track Video 2 dalam Timeline. 
 

3. Sehingga tampilan Sequence Monitor Window akan tampak seperti gambar berikut. 
 

4. Lalu geser Current Time Marker ke posisi waktu 00:00:00:00. 
 

5. Kemudian pilih clip title BUNGA.prtl. Lalu buka Tab Effect Controls yang berada dalam 

Source Monitor Window. 

6. Kemudian pada Tab Effect Controls klik tombol Toggle Animation yang ada pada pilihan 

Position di dalam Motion. 
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Gambar 9.72 Perubahan nilai Position 

 

 

 

 

 

 

 

 

Gambar 9.73 Tampilan Sequence Monitor Window pada posisi 00:00:00:00 setelah dilakukan perubahan nilai Position 

 

 

 

 

 

 

 

 

 
Gambar 9.74 Penggeseran Current Time Marker 

 

 

7. Selanjutnya ubah nilai Position menjadi 50 , 288. 
 

8. Sehingga tampilan Sequence Monitor Window akan tampak seperti gambar berikut. 
 

9. Setelah itu geser Current Time Marker ke posisi ujung kanan clip title BUNGA.prtl. 
 

10. Sehingga tampilan Sequence Monitor Window akan tampak seperti gambar berikut. 

 

 
Gambar 9.71 Tampilan Toggle Animation 
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Gambar 9.76 Perubahan nilai property Position pada Tab Effect Controls 

 

 

 

 

 

 

 

 

Gambar 9.77 Tampilan Sequence Monitor Window setelah dilakukan perubahan nilai Position 

 

 

11. Kemudian ubah nilai Position yang ada dalam Tab Effect Controls menjadi 650 , 288. 
 

12. Maka tampilan Sequence Monitor Window akan tampak seperti gambar berikut. 
 

13. Lalu jalankan movie, maka akan terlihat animasi perpindahan posisi title dari kiri ke kanan. 

 

 

 

 

 

 

 

 

Gambar 9.75 Tampilan Sequence Monitor Window pada posisi 00:00:05:24 
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BAB 10 

 AUDIO TREATMENT 
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Gambar 10.1 Tampilan pop-up menu pada clip audio 

 

 

 

 

 

 

Gambar 10.2 Kotak dialog Clip Gain 

Adobe Premiere Pro mendukung berbagai format file audio, yaitu format AIFF, AVI, 

MOV, MP3, WAV, dan WMA. Pada bab ini akan dibahas berbagai teknik untuk 

mengolah audio dalam Adobe Premiere Pro. 

 

Mengatur Audio Gain 

Untuk mengatur audio gain/volume pada clip audio caranya : 
 

1. Klik kanan pada clip audio yang terdapat dalam Track Audio 1 pada Timeline Window. Maka 

akan tampil pop‐up menu. 

2. Kemudian pada pop‐up menu pilih Audio Gain. 

 

3. Selanjutnya akan tampil kotak dialog Clip Gain. Atur volume‐nya dalam satuan dB (desibel). 

Lalu klik OK. 

4. Untuk mengembalikan audio gain pada posisi normal (0,0 dB) gunakan tombol Normalize. 

 

Keyframing pada Audio Gain 

Parameter audio gain dapat dianimasikan untuk menghasilkan efek Fade-In dan Fade- 

Out. Berikut ini langkah-langkahnya : 

1. Pilih clip audio yang ada dalam Timeline Window pada Track Audio 1. 
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Gambar 10.3 Tombol Show Keyframes 

 
 
 
 
 
 
 
 
 
 

Gambar 10.4 Pop-up menu Show Keyframes 

 

 
Gambar 10.5 Tampilan tombol Show Keyframes setelah dipilih Show Clip Volume 

 

 

 

 
Gambar 10.6 Tampilan clip audio dalam Track Audio 1 

2. Klik tombol Show Keyframes dalam Track Audio 1, sehingga akan tampil pop‐up menu. 
 

3. Kemudian pada pop‐up menu pilih Show Clip Volume. 

 

4. Maka tampilan tombol Show Keyframes akan berubah seperti pada gambar berikut. 
 

5. Sehingga tampilan clip audio dalam Track Audio 1 akan menjadi seperti di bawah ini. 
 

6. Untuk membuat efek Fade‐In caranya, geser Current Time Marker ke posisi 00:00:00:00. 

Kemudian buka Tab Effect Controls yang berada dalam Source Monitor Window. Selanjutnya 

expand pilihan Volume yang terdapat dalam Audio Effects. 

 

 

 

 

 

 

 

 

 

 

 
Gambar 10.7 Property Volume dalam Tab Effects Control 
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Gambar 10.8 Tombol Add/Remove Keyframes 

 

 

 

 

Gambar 10.10 Tampilan clip audio dalam Track Audio 1 setelah mengalami perubahan nilai Level 

 

 

 

 
Gambar 10.11 Pembuatan keyframe dan perubahan nilai Level dalam Tab Effect Controls 

 
 
 
 

 
Gambar 10.12 Tampilan clip audio setelah dibuat keyframe dan perubahan nilai Level pada posisi 00:00:02:00. 

7. Lalu klik tombol Add/Remove Keyframes yang berada dalam pilihan Level untuk membuat 

keyframe. 

8. Selanjutnya ubah nilai Level menjadi ‐00 dB, atau geser play head Level hingga pojok sebelah 

kiri. 

 
 

9. Sehingga tampilan clip audio pada Track Audio 1 akan tampak seperti pada gambar di bawah 

ini. 

10. Setelah itu geser Current Time Marker ke posisi waktu 00:00:02:00. 

 

11. Kemudian klik tombol Add/Remove Keyframes pada pilihan Level untuk membuat keyframe. 

Selanjutnya ubah nilai Level menjadi 00 dB. 

12. Sedangkan untuk membuat efek Fade‐Out caranya, geser Current Time Marker ke posisi 

00:00:07:00. 

 

 

 
 

Gambar 10.9 Perubahan nilai Level 
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Gambar 10.13 Tampilan clip audio pada posisi 00:00:07:00 

 

 

 

 
Gambar 10.14 Tampilan perubahan nilai Level pada posisi 00:00:08:23 

 

 

 

Gambar 10.15 Tampilan clip audio pada posisi 00:00:08:23 

13. Lalu klik tombol Add/Remove Keyframe yang ada pada pilihan Level untuk membuat 

keyframe. 

14. Lalu geser Current Time Marker ke posisi 00:00:08:23, atau di ujung kanan clip audio. 

 

15. Setelah itu klik tombol Add/Remove Keyframe pada pilihan Level untuk membuat keyframe. 

 

16. Kemudian ubah nilai Level menjadi ‐00 dB. 
 

17. Maka tampilan clip audio pada posisi 00:00:08:23 akan tampak seperti berikut. 
 

 

Merekam Audio Analog 

Adobe Premiere Pro telah menyediakan fasilitas perekaman audio analog, jadi kita tidak 

perlu menggunakan software lain untuk merekam audio analog. Berikut ini langkah- 

langkahnya : 

1. Tancapkan jack microphone ke dalam port sound input pada Sound Card. 

 

2. Kemudian setting audio hardware menggunakan pilihan Edit > Preferences > Audio 

Hardware. 

3. Maka akan tampil kotak dialog Preferences, apabila sound card terinstal dengan baik maka 

nama driver sound card akan tertera disini. Lalu klik OK. 



Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 10.17 Tampilan Workspace Audio 

 

 
Gambar 10.18 Tombol Enable track for recording 

 

 

4. Lalu pada menu pilih Window > Workspace > Audio. Sehingga tampilan Adobe Premiere Pro 

akan tampak seperti pada gambar berikut ini. 

5. Kemudian klik tombol Enable track for recording yang berada dalam Audio Mixer Window. 
 

 

6. Maka di dalam Audio Mixer Window akan tampil rollout yang menampilkan nama driver 

sound card. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 10.16 Tampilan kotak dialog Preferences 
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Gambar 10.20 Tombol Record 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 10.21 Tampilan Audio Mixer Window pada saat proses perekaman 

 

 

7. Setelah itu lakukan perekaman menggunakan tombol Record yang berada di sebelah kanan 

bawah Audio Mixer Window. 

8. Untuk menghentikan proses perekaman audio caranya klik Record satu kali lagi. 

 

9. Maka hasil perekaman audio akan tampil dalam Timeline Window pada Track Audio yang 

aktif. 

 

Efek Audio 

Adobe Premiere Pro menyediakan banyak efek audio untuk diaplikasikan pada  clip 

audio, diantaranya Balance, Bandpass, Bass, Channel Volume, DeNoiser, Delay, 

Dynamics, EQ, Fill Left, Fill Right, Highpass, Invert, Lowpass, MultibandCompressor, 

 

 

 
 

Gambar 10.19 Rollout driver audio hardware 
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Gambar 10.22 Tampilan Audio Effects pada Tab Effects di dalam Project Window 

Multitap Delay, Notch, Parametric EQ, PitchShifter, Reverb, Swap Channels, Treble, dan 

Volume. 

 

Memberi Efek Audio 

Cara yang paling mudah untuk mengaplikasikan efek adalah dengan : 
 

1. Pilih clip audio yang ada dalam Track Audio di dalam Timeline Window. 

 

2. Kemudian buka Tab Effects yang ada dalam Project Window. Lalu expand pilihan Audio 

Effects, kemudian expand pula pilihan Stereo. 

3. Setelah itu pilih sebuah efek audio yang ada di dalamnya, lalu drag efek tersebut dan letakkan 

pada clip audio dalam Timeline Window. 

4. Setelah itu buka Tab Effect Controls yang berada dalam Monitor Window untuk mengatur 

parameter efek audio. 

5. Untuk menghapus efek audio, pilih efek audio yang tampil dalam Tab Effect Control 

kemudian tekan tombol Delete pada keyboard, maka efek audio akan terhapus. 
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Gambar 10.24 Pilihan efek EQ pada Tab Effects dalam Project Window 

 

 
 

Menggunakan Efek Equalizer 

Adobe Premiere Pro juga menyediakan equalizer untuk mengatur frekuensi Bass dan 

Treble tetapi dikategorikan sebagai efek audio. Untuk mengaplikasikan efek ini pada clip 

audio caranya : 

1. Pilih clip audio yang ada dalam Track Audio di dalam Timeline Window. 

 

2. Kemudian buka Tab Effects yang ada dalam Project Window. Lalu expand pilihan Audio 

Effects, kemudian expand pula pilihan Stereo. 

3. Setelah itu pilih efek audio EQ yang ada di dalamnya, lalu drag efek tersebut dan letakkan 

pada clip audio dalam Timeline Window. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 10.23 Tampilan property efek audio dalam Tab Effect Controls 
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Gambar 10.26 Susunan clip dalam Timeline Window 

 

 
 

Transisi Audio/Crossfade 

Seperti halnya video, clip audio juga dapat diberi transisi. Fungsi dari transisi audio 

adalah membuat perpindahan audio yang halus pada perpindahan clip. Berikut ini 

langkah-langkah untuk memberi transisi pada clip audio : 

1. Susun sebuah buah clip video yang memiliki audio dalam Timeline Window. 

 

2. Kemudian susun sebuah clip lagi tetapi buat letaknya overlap dengan clip pertama untuk 

memberikan durasi pada transisi audio. 

3. Buka tab Effects dalam Project Window, lalu expand pilihan Audio Transition dan Crossfade. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 10.25 Tampilan pengaturan equalizer dalam Tab Effect Controls 
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Gambar 10.28 Pengaplikasian transisi audio pada area overlap dalam Track Audio 

 

 

4. Setelah itu pilih efek transisi audio Constant Gain, lalu drag dan drop ke dalam area overlap 

pada Track Audio. 

5. Kemudian kita dapat melakukan pengaturan efek pada Tab Effect Controls dalam Monitor 

Window. 

 

Teknik transisi audio sering disebut juga dengan nama Split Edit, yaitu metode untuk 

memotong suatu clip audio, sehingga suara dari clip muncul terlebih dahulu daripada 

videonya (lazim disebut J-cut) atau suara dari clip pertama terus muncul dalam clip kedua 

(lazim disebut L-cut). 

 

 

 

 

 

 

 

 
 

Gambar 10.29 Pengaturan transisi audio dalam Tab Effect Controls 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 10.27 Tampilan Audio Transition dalam Tab Effects 
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BAB 11 

 TIP DAN TRIK 
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Gambar 11.1 Letak efek Color Corrector pada Tab Effects dalam Project Window 

Bab ini akan membahas berbagai tips dan trik yang biasa digunakan oleh para profesional 

dalam bidang video editing untuk menciptakan animasi dan visual effect. 

 

Koreksi Warna Clip 

Sebagai software editing video untuk para profesional Adobe Premiere Pro menyediakan 

fasilitas koreksi warna. Hal ini jelas memberi kekuatan baru bagi para pemakai setia 

Adobe Premiere, karena pada versi sebelumnya (versi 5 dan 6) fasilitas ini belum 

disediakan, padahal fasilitas ini sangat memudahkan para video editor untuk mengkoreksi 

warna pada clip. Untuk mengkoreksi warna pada Adobe Premiere Pro digunakan dua 

efek yaitu Color Corrector dan Color Match. 

 

Menggunakan Color Corrector 

Untuk menggunakan Color Corrector dalam koreksi warna clip caranya : 
 

1. Susun sebuah clip video ke dalam Timeline Window. 

 

2. Aktifkan workspace color correction caranya pada menu pilih Window > Workspace > Color 

Correction. 

3. Kemudian buka Tab Effects yang ada pada Project Window. 

 

4. Expand pilihan Video Effects. 

 

5. Expand pilihan Image Control dalam Video Effects. 

 

6. Pilih Color Corrector, kemudian drag ke dalam clip yang ada pada Timeline Window untuk 

mengaplikasikan efek ini. 
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Gambar 11.2 Tampilan property Color Corrector dalam Tab Effect Controls 

7. Setelah itu buka Tab Effect Controls yang ada dalam Project Window untuk melakukan 

pengaturan efek. 

8. Hasil koreksi warna dapat disimpan dalam bentuk file, nantinya kita dapat menggunakan 

setting yang telah disimpan untuk mengkoreksi warna clip lain, caranya expand pilihan Setting 

Keys dalam efek Color Corrector. Kemudian klik tombol Save File yang ada di bawahnya. 

 

9. Setelah itu akan tampil kotak dialog Save Color Corrector Settings As. Isikan nama file 

kemudian tekan Save untuk menyimpan. Maka file setting akan disimpan dalam format 

*.prccs. 

 

 

 
Gambar 11.3 Tampilan Setting Keys 

 
 

 
Gambar 11.4 Tombol Save File 
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Gambar 11.6 Aktifasi Split Screen Preview 

 

 

10. Untuk memudahkan kita dalam proses koreksi warna terutama untuk membandingkan hasil 

koreksi warna dengan clip asli caranya aktifkan pilihan Split Screen Preview. 

11. Maka dalam Sequence Monitor Window akan tampil sebuah klip dengan dua buah tampilan, 

jadi monitor dibagi menjadi 2 area, area sebelah kiri menampilkan clip dengan warna asli 

sedangkan area sebelah kanan menampilkan hasil koreksi warna. 

 
 

Menggunakan Color Match 

Selain menggunakan efek Color Corrector kita juga dapat menggunakan efek Color 

Match untuk mengkoreksi warna. Berikut ini langkah-langkah menggunakan Color 

Match : 

1. Susun sebuah clip video ke dalam Timeline Window. 

 

2. Aktifkan workspace color correction caranya pada menu pilih Window > Workspace > Color 

Correction. 

 

 

 

 

 

 

 

 

 
Gambar 11.7 Tampilan Split Screen Preview dalam Sequence Monitor Window 

 

 

 

 

 

 

 

 

 
 

Gambar 11.5 Kotak dialog Save Color Corrector Settings As 
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Gambar 11.8 Letak efek Color Match pada Tab Effects dalam Project Window 

3. Kemudian buka Tab Effects yang ada pada Project Window. 

 

4. Expand pilihan Video Effects. 

 

5. Expand pilihan Image Control dalam Video Effects. 

 

6. Pilih Color Match, kemudian drag ke dalam clip yang ada pada Timeline Window untuk 

mengaplikasikan efek ini. 

7. Setelah itu buka Tab Effect Controls yang ada dalam Project Window untuk melakukan 

pengaturan efek. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 11.9 Tampilan property Color Match dalam Tab Effect Controls 
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Gambar 11.10 Tampilan clip referensi dalam Source Monitor Window 

 

 

 
Gambar 11.12 Tombol Match 

8. Kemudian untuk menyamakan warna pilih clip referensi, clip inilah yang menjadi acuan 

penyamaan warna, caranya drag salah satu clip yang ada dalam Project Window ke dalam 

Source Monitor Window. 

9. Lalu pilih warna yang ingin disamakan dalam clip referensi menggunakan tombol 

Eyedroppers yang ada pada masing‐masing property Color Match dalam Tab Effect Controls. 

 

10. Setelah   dilakukan   pemilihan   warna menggunakan  Eyedroppers selanjutnya aplikasikan 

pengaturan tersebut dengan cara klik tombol Match. 

11. Maka pengaturan akan diaplikasikan dalam clip, dan tampilannya dapat dilihat pada Sequence 

Monitor Window. 

 

 
Gambar 11.11 Tombol Eyedroppers 
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Teknik Keying 

Untuk mengganti latar belakang clip digunakan teknik keying, fungsinya untuk membuat 

transparansi, kemudian mengisi area transparan tersebut dengan clip lain. Dalam bahasan 

ini kita akan mengupas berbagai teknik keys diantaranya Green Screen Key, Blue Screen 

Key, Chroma Key, RGB Difference Key, Luma Key, Multiply dan Screen Key. 

Terkadang dalam skenario terdapat adegan yang tidak mungkin dilakukan dengan live 

shoot, misalnya adegan orang terbang di angkasa. Maka untuk mengatasi kendala ini 

digunakan teknik keying untuk efisiensi biaya. Pertama kita harus mengambil gambar 

talent (misal orang dengan posisi telumgkup seolah-olah sedang terbang) dengan 

background berwarna tertentu (teknik Green Screen memakai warna hijau sebagai 

background). Kedua kita ambil gambar latar belakang yang akan dipakai (misalnya 

gambar langit untuk adegan orang terbang di angkasa). Setelah itu kedua hasil 

pengambilan gambar digabungkan menggunakan teknik superimpose, letakkan gambar 

talent berbackground warna pada layer paling atas, dan gambar langit pada layer 

dibawahnya. Kemudian aplikasikan efek keying (misalnya Green Screen Keying) pada 

layer yang terletak paling atas. Maka hasilnya background berwarna hijau akan 

digantikan dengan gambar latar belakang langit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 11.13 Tampilan clip yang telah dikoreksi warna menggunakan Color Match dalam Sequence Monitor Window 
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Gambar 11.17 Clip bergambar langit sebagai latar belakang 

 

 
 

Green Screen Key 

Pada teknik Green Screen digunakan background dengan warna RGB (0,255,0) atau 

warna Green-nya 255. Usahakan pada saat pengambilan gambar/shooting digunakan 

pencahayaan (lighting yang merata), sehingga hasil Green Screen akan maksimal. 

Untuk mengaplikasikan teknik Green Screen Key caranya : 
 

1. Susun clip dengan background langit/space dalam Track Video 1. 
 

 

 

 

 

 

 

 

 
 

Gambar 11.14 Gambar talent dengan latar belakang hijau 

 
 
 
 
 
 
 
 
 

Gambar 11.15 Gambar latar belakang berupa langit 

 
 
 
 
 
 
 
 
 
 

Gambar 11.16 Background hijau yang digantikan latar belakang langit menggunakan teknik Green Screen 
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Gambar 11.18 Clip dengan background berwarna hijau 

 

 

 

 

 

 

 

 

 

 

 

Gambar 11.17 Letak efek Green Screen Key dalam Tab Effects 

2. Susun clip yang memiliki background warna hijau ke dalam Track Video 2 (superimpose). 
 

3. Buka Tab Effects yang ada dalam Project Window. 

 

4. Expand pilihan Video Effects. 

 

5. Expand pilihan Keying. 

 

6. Pilih Green Screen Key, kemudian drag dan letakkan pada clip yang memiliki background 

berwarna hijau. 

7. Kemudian atur property efek Green Screen Key yang ada pada Tab Effect Controls di dalam 

Source Monitor Window. Lalu atur parameter Similarity untuk memperbesar atau 

mempersempit range warna. Kemudian atur parameter Smoothing, pilih High untuk 

memperhalus area pinggir gambar sehingga tampak lebih menyatu. 

 

 

 

 

 

 
 

Gambar 11.18 Pengaturan property efek Green Screen Key 
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Gambar 11.19 Hasil akhir Green Screen Key 

 

 

 

 

 

 

 

 

 
 

Gambar 11.20 Letak efek Blue Screen Key dalam Tab Effects 

 
 
 
 
 
 
 
 
 

Gambar 11.21 Pengaturan efek Blue Screen Key dalam Tab Effect Controls 

8. Sehingga tampilan akhirnya tampak seperti pada gambar berikut. 
 

 

Blue Screen Key 

Pada teknik Blue Screen digunakan background dengan warna RGB (0,0,255) atau warna 

Blue-nya 255. Usahakan pada saat pengambilan gambar/shooting digunakan pencahayaan 

(lighting yang merata), sehingga hasil Blue Screen akan maksimal. Untuk 

mengaplikasikan teknik Blue Screen caranya sama dengan teknik Green Screen diatas, 

perbedaannya terletak pada video efek yang digunakan, pada teknik Blue Screen 

digunakan efek video Blue Screen Key yang terletak pada pilihan Keying pada Video 

Effects dalam Tab Effect. Kemudian lakukan pengaturan efek Blue Screen Key dalam 

Tab Effect Controls. 



Belajar Gratis di BelajarSendiri.Com - © HakCipta 2006 BelajarSendiri.Com 

Editing Video Menggunakan Adobe Premiere Pro 

 

 

 

 
 

Chroma Key 

Apabila hasil pengambilan gambar (baik teknik Green Screen maupun Blue Screen) tidak 

sempurna (pencahayaan tidak merata) sehingga terjadi bayangan pada background. Maka 

hal ini dapat diatasi dengan teknik Chroma Key. Setelah diaplikasikan pada clip dengan 

background warna (hijau), lalu atur property Chroma Key yang ada dalam Tab Effect 

Controls. Pada pilihan Color pilih warna background yang akan dihilangkan, kita dapat 

menggunakan tombol eyedropper untuk menunjuk langsung pada clip. Lalu atur 

Similarity sampai warna background tak tampak. 

 

 

 

 

 

 

 

 
 

Gambar 11.22 Clip dengan background berwarna biru 

 
 
 
 
 
 
 
 
 

Gambar 11.23 Clip bergambar panorama sebagai latar belakang 

 
 
 
 
 
 
 
 
 

Gambar 11.24 Hasil akhir teknik Blue Screen menggunakan efek video Blue Screen Key 
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Gambar 11.27 Clip dengan warna background selain hijau dan biru 

 

 
 

RGB Difference Key 

Untuk background dengan warna-warna selain warna hijau dan biru dapat digunakan efek 

RGB Difference Key. Pilih efek RGB Difference Key lalu aplikasikan efek ini pada clip 

yang akan dihilangkan warna backgroundnya. Kemudian atur property-nya dalam Tab 

Effect Controls. Gunakan parameter Color untuk memilih warna background yang akan 

dihilangkan. Lalu atur pula parameter Similarity sampai warna background hilang. Untuk 

menghilangkan background berwarna putih lebih mudah digunakan efek Luma Key. 

 

 

 

 

 

 

 

 

 

 

Gambar 11.25 Letak efek Chroma Key dalam Tab Effects 

 
 
 
 
 
 
 
 
 
 
 

 
Gambar 11.26 Property efek Chroma Key dalam Tab Effect Controls 
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Image Matte 

Kita dapat menggunakan suatu image/gambar untuk menghilangkan area tertentu dari 

suatu clip. Gambar ini disebut dengan Image Matte (Image Mask). Dalam sebuah Image 

Matte, area yang berwarna hitam adalah transparan, sedangkan area yang berwarna putih 

 

 

 

 

 

 

 

 
 

Gambar 11.28 Clip yang digunakan sebagai latar belakang 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Gambar 11.29 Letak efek RGB Difference Key dalam Tab Effects 

 
 
 
 
 
 
 
 
 
 

Gambar 11.30 Property efek RGB Difference Key dalam Tab Effect Controls 

 
 
 
 
 
 
 
 
 
 

Gambar 11.31 Hasil akhir pengaplikasian RGB Difference Key 
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Gambar 11.32 Tampilan clip dalam Sequence Monitor Window 

tidak transparan (opaque), dan area yang abu-abu adalah semitransparan. Berikut ini 

langkahnya : 

1. Susun sebuah clip video ke dalam Timeline Window. 
 

2. Lalu siapkan/buat sebuah gambar hitam putih (dengan format file JPEG, BMP atau TIFF) 

menggunakan tool grafis semacam Adobe Photoshop CS. 

 

3. Aplikasikan Video Effect > Keying > Image Matte Key yang ada dalam Tab Effects pada Project 

Window ke dalam clip video yang ada di Timeline. 

4. Lalu buka Tab Effect Controls untuk menampilkan property efek Image Matte. 

 

 

 

 

 

 

 

 

 
Gambar 11.33 Tampilan gambar hitam putih 
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Gambar 11.36 Tombol Setup 

 

 

5. Kemudian klik tombol Setup yang ada dalam property Image Matte Key yang ada pada Tab 

Effect Controls. 

6. Maka akan tampil kotak dialog Select a Matte Image, lalu pilih file gambar hitam putih tadi. 

Kemudian tekan Open. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 11.37 Kotak dialog Select a Matte Image 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 11.34 Letak efek Image Matte dalam Tab Effects 

 
 
 
 
 
 
 

Gambar 11.35 Property efek Image Matte Key dalam Tab Effect Controls 
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Gambar 11.38 Hasil Image Matte dalam Sequence Monitor Window 

 

 

 

 

 
Gambar 11.39 Aktifasi pilihan Reverse dalam Tab Effect Controls 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 11.40 Tampilan aktifasi Reverse 

7. Maka hasilnya akan tampak seperti pada gambar di bawah ini. 
 

8. Apabila pilihan Reverse di aktifkan, maka pengaplikasian Image Matte akan terbalik. 
 

 

Difference Matte 

Difference Matte digunakan dengan membandingkan antara gambar (Matte) dengan clip 

video, kemudian bagian yang sama akan dibuat transparan. Difference Matte biasanya 

digunakan untuk menghilangkan background statis dari clip video, lalu kita dapat 

menggantinya menggunakan background lain. Berikut ini langkah-langkahnya : 

1. Susun clip video kapal layar dengan latar belakang jembatan kedalam Timeline tempatkan 

pada Track Video 2. 
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Gambar 11.42 Tampilan clip yang difungsikan sebagai background pengganti 

 

 

 

 

 

 

 

 

 

 
Gambar 11.43 Letak efek Difference Matte Key dalam Tab Effects 

 

 

2. Susun sebuah clip sebagai latar belakang pengganti pada Timeline tempatkan pada Track 

Video 1. 

3. Drag efek video Difference Matte Key yang ada dalam Video Effects > Keying pada Tab Effects. 
 

4. Kemudian buka Tab Effect Controls yang berada dalam Monitor Window untuk melakukan 

pengaturan pada property efek Difference Matte Key. 

 

5. Kemudian klik tombol Setup yang berada pada property efek Difference Matte Key 

 

 

 

 

 

 

 
Gambar 11.44 Property efek Difference Matte Key dalam Tab Effect Controls 

 

 

 

 

 

 
Gambar 11.41 Tampilan clip kapal layar 
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Gambar 11.46 kotak dialog Select a Difference Matte Image 

 

 

 

 

 

 
Gambar 11.47 Tampilan gambar background yang akan diganti (Matte) 

 

 

 

 

 

 
Gambar 11.48 Hasil akhir Difference Matte 

 

 

6. Maka akan tampil kotak dialog Select a Difference Matte Image. 
 

7. Kemudian pilih file gambar background (Matte) yang ingin digantikan, lalu tekan Open. 
 

8. Maka tampilan aplikasi Difference Matte akan tampak seperti pada gambar berikut. 
 

 

Garbage Matte 

Ketika menggunakan efek Green Screen atau Blue Screen mungkin terdapat bagian dari 

clip yang ingin kita hilangkan, misalnya tampilan microphone/boom. Caranya aplikasikan 

efek Green Screen/Blue Screen Key pada clip yang memiliki background warna solid. 

 

 

Gambar 11.45 Tombol Setup 
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Gambar 11.49 Clip dengan background biru (blue screen) 

 
 
 
 
 
 
 
 
 
 
 

Gambar 11.50 Pengaplikasian dua buah efek yaitu Blue Screen Key dan Garbage Matte 

 
 
 
 
 
 
 
 
 
 

Gambar 11.51 Pengaturan corner pin property efek Garbage Matte dalam Sequence Monitor Window 

 
 
 
 
 
 
 
 
 

Gambar 11.52 Hasil akhir pengaplikasian efek Blue Screen Key dan Garbage Matte 

Kemudian aplikasikan efek Garbage Matte pada clip tersebut. Lalu atur corner pin pada 

clip dalam Sequence Monitor Window. 

 

Picture in Picture 

Teknik Picture in Picture digunakan untuk menampilkan suatu clip diatas clip lain dengan 

ukuran yang lebih kecil. Berikut ini langkah-langkahnya : 
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Gambar 11.53 Susunan clip dalam Timeline Window 

 

 

 

 

 

 

 

 

 
Gambar 11.55 Tampilan Picture in Picture dalam Monitor Window 

1. Susun clip background ke dalam Track Video 1. 

 

2. Susun clip kedua dalam Track Video 2. 

 

3. Susun clip ketiga dalam Track Video 3. 

 

4. Sehingga tampilan susunan clip dalam Timeline akan tampak seperti pada gambar berikut. 
 

5. Lalu atur parameter Position dan Scale dalam property Motion untuk clip yang berada pada 

Track Video 2 dan Track Video 3. 

 

6. Sehingga tampilannya akan menjadi seperti pada gambar berikut. 
 

7. Kita dapat menambahkan efek bayangan pada clip pada Track Video 2 dan 3 menggunakan 

efek Perspective > Drop Shadow dalam Video Effects. 

 

 

 

 

 

 

 

 

 
Gambar 11.54 Pengaturan parameter Position dan Scale dalam property Motion 
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Gambar 11.57 Susunan clip dalam Timeline Window 

 
 
 
 
 
 
 
 
 
 
 

Gambar 11.58 Tampilan susunan clip dalam Monitor Window 

 

 
 

Animasi Title Menggunakan Transisi Video 

Selain animasi menggunakan keyframe, terdapat metode instan untuk menganimasikan 

title ataupun clip, caranya dengan menggunakan efek transisi yang ada. Berikut ini 

langkahnya : 

1. Susun clip background dalam Track Video 1. 

 

2. Susun clip title (misal gambar dengan format PSD) dalam Track Video 2. 
 

3. Kemudian buka Tab Effects, Pilih Video Transition > 3D Motion > Curtain. 

 

 

 

 

 

 

 

 

 
Gambar 11.56 Tampilan penambahan efek Drop Shadow dengan warna bayangan putih dalam Monitor Window 
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Gambar 11.60 Letak transisi dalam Timeline Window 

 

 

 

 

 
Gambar 11.62 Tampilan animasi clip title 

 

 

4. Lalu drag efek transisi Curtain ke dalam Timeline, letakkan pada daerah awal clip title. 
 

5. Kemudian lakukan pengaturan durasi pada transisi Curtain tersebut dalam Tab Effect 

Controls. 

 

6. Lalu jalankan movie, maka penampilan animasi dalam Monitor Window akan tampak seperti 

pada gambar berikut. 

 

 

 

 

 

 

 

 

 

 

 
Gambar 11.61 Property transisi Curtain dalam Tab Effect Controls 

 

 

 

 

 

 

 

 

Gambar 11.59 Letak efek transisi Curtain 
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Gambar 11.63 Transisi kedua pada ujung kanan clip title 

 

 

 

 

 

 
 

Gambar 11.65 Susunan clip dalam Timeline Window 

7. Untuk membuat animasi clip title menghilang, caranya berikan transisi pada area ujung kanan 

clip title. 

8. Atur property transisi pada clip kedua lewat Tab Effect Control. Untuk membuat animasi clip 

menghilang, aktifkan pilihan Reverse. 

 
 

Animasi Logo 

Gambar logo 2d dapat kita animasikan menyerupai animasi 3d menggunakan efek video 

Perspective. Berikut ini langkah-langkahnya : 

1. Susun clip background ke dalam Timeline Window, letakkan dalam Track Video 1. 

 

2. Susun clip logo (misalnya gambar dengan format PSD) ke dalam Timeline, letakkan dalam 

Track Video 2. 

 

 
Gambar 11.64 Aktifasi pilihan Reverse 
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Gambar 11.67 Letak efek video Basic 3D dalam Tab Effects 

 

 

3. Kemudian buka Tab Effects dalam Project Window. 

 

4. Expand pilihan Video Effects. 

 

5. Expand pilihan Perspective dalam Video Effects. 
 

6. Pilih Basic 3D, kemudian drag dan drop ke dalam clip logo yang terletak pada Track Video 2 

dalam Timeline. 

7. Kemudian buka Tab Effect Controls pada Monitor Window, lalu expand property efek Basic 

3D. 

 

 

 

 

 

 

 

 

 
Gambar 11.66 Tampilan susunan clip dalam Monitor Window 
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Gambar 11.69 Tampilan Toggle Animation 

 

 

 

 

 

 

 

 
Gambar 11.70 Perubahan nilai Swivel 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 11.71 Tampilan perubahan nilai Swivel dalam Monitor Window 

 

 

 

 
Gambar 11.72 Perubahan nilai Swivel pada posisi akhir clip logo 

 

 

8. Kemudian kita akan menganimasikan property Swivel pada efek Basic 3D caranya geser 

Current Time Marker ke posisi waktu 00:00:00:00. 

9. Lalu klik tombol Toggle Animation pada property Swivel untuk memulai proses keyframing. 
 

10. Selanjutnya ubah nilai Swivel menjadi 0 X ‐57.0°. 
 

11. Setelah itu geser Current Time Marker ke posisi akhir clip, misalnya posisi 00:00:22:14. 

 

12. Kemudian ubah lagi nilai Swivel menjadi 0 X ‐132.0°. 
 

Gambar 11.68 Property efek Basic 3D dalam Tab Effect Controls 
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13. Setelah itu jalankan movie, maka terlihat animasi perspective 3 dimensi. Kita dapat pula 

menganimasikan property efek Basic 3D yang lain seperti Tilt. 

 

Video Untuk Broadcast 

Jika kita membuat content video yang akan ditayangkan di televisi (broadcast) maka kita 

perlu berhati-hati, karena tampilan layar televisi berbeda dengan tampilan pada monitor 

komputer. Monitor komputer membaca warna sebagai kombinasi dari warna RGB, 

sedangkan layar televisi membaca warna sebagai sinyal-sinyal yang terbatas dalam 

amplitudo tertentu. Ukuran/satuan amplitudo adalah IRE, yang batas maksimum 

pembacaannya adalah 120 IRE. Berikut ini tips yang dapat dipakai ketika menyiapkan 

video untuk broadcast : 

 Preview movie kita dalam layar TV untuk memastikan tampilannya sesuai dengan yang kita 

inginkan. 

 Hindari penggunaan warna dengan saturasi yang tinggi. 

 

 Jangan memakai warna hitam dan putih yang murni. 

 

 Hindari menggunakan garis horisontal selebar 1 pixel, karena dapat menyebabkan flicker. 

 

Untuk memastikan agar warna ditampilkan dengan baik di layar televisi, kita dapat 

menggunakan efek video Broadcast Color fungsinya untuk mengurangi saturasi warna 

sampai ke level aman. 

 

 

 

 

 

 

 

 

 
Gambar 11.73 Tampilan perubahan nilai Swivel pada posisi akhir clip logo 
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Terdapat beberapa parameter dalam property efek video Broadcast Color. Parameter 

Broadcast Locale untuk mengatur seleksi format yang dipakai, NTSC atau PAL 

(Indonesia memakai standar PAL). Parameter How to Make Color Safe digunakan untuk 

mengatur terangnya pixel (parameter Reduce Luminance) dan mengurangi informasi 

warna dari clip (parameter Reduce Saturation). Kita dapat pula menggunakan pilihan Key 

Out Unsafe dan Key Out Safe untuk mengetahui pixel warna yang termasuk kategori 

aman dan tidak. Sedangkan parameter Maximum Signal untuk 

 

Menghilangkan Noise Audio 

Seringkali pada saat merekam suara/audio suara-suara disekeliling/atmosphere ikut pula 

terekam, termasuk juga noise yang ditimbulkan peralatan elektronik. Untuk 

menghilangkan desis/noise ini digunakan efek Bandpass. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 11.74 Letak efek video Broadcast Color dalam Tab Effects 

 
 
 
 
 
 
 
 
 

Gambar 11.75 Property efek Broadcast Color dalam Tab Effect Controls 
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Gambar 11.77 Property efek Bandpass yang ada dalam Tab Effect Controls 

 

 

Aplikasikan efek audio ini pada clip audio dalam Timeline yang terletak dalam Track 

Audio. 

 

Menggunakan Plug-In 2d3 SteadyMove Untuk 

Menstabilkan Gambar 

Plug-In merupakan sebutan bagi aplikasi tambahan yang diciptakan untuk menambah 

fungsi dan performa dari software host/induk. Plug-In biasanya dibuat oleh pihak ketiga 

jadi bukan dibuat oleh developer software induk. Fungsi Plug-In dalam Adobe Premiere 

sangat beragam biasanya dibuat untuk menambah pilihan transisi, efek video dan 

animasi. Tersedia banyak informasi mengenai Plug-In di internet yang bisa kita dapatkan, 

biasanya dalam situsnya, para vendor pembuat Plug-In menyediakan versi Trial, yang 

dapat kita download. 

 

Tentang SteadyMove 

SteadyMove merupakan Plug-In Adobe Premiere dan Adobe After Effects yang dibuat 

oleh perusahaan 2d3 yang berada di Inggris. Biasanya dalam CD Instalasi Adobe 

Premiere Pro telah disertai file instalasi Plug-In ini. 

 

 

 

 

 

 

 

 

 

 

 

Gambar 11.76 Letak efek audio Bandpass pada Tab Effects 
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Gambar 11.78 Kotak dialog pembuka 

SteadyMove berfungsi untuk menstabilkan gambar dari gerakan-gerakan yang tidak 

diinginkan pada saat pengambilan gambar berlangsung, selain itu SteadyMove juga 

berfungsi menghaluskan proses zooming pada gambar. 

Terkadang pada saat pengambilan gambar yang tidak menggunakan tripod kamera terjadi 

pergerakan atau getaran kamera/camera shaking yang tidak disengaja, untuk 

menstabilkan gambar digunakanlah Plug-In ini. 

 

Proses Instalasi 

Untuk menginstalasikan Plug-In SteadyMove ke dalam Adobe Premiere langkahnya : 
 

1. Klik dua kali file Setup yang berada di dalam folder StedyMove. 

 

2. Maka akan tampil kotak dialog pembuka 2d3 SteadyMove for Adobe Premiere Pro‐ 

InstallShield Wizard. Lalu klik Next untuk melanjutkan. 

3. Selanjutnya akan tampil kotak dialog Customer Information, lalu isikan User Name dan 

Organization. Setelah itu klik Next. 
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Gambar 11.80 Kotak dialog Destination Folder 

 

 

4. Selanjutnya akan tampil kotak dialog Destination Folder yang menunjukkan lokasi tujuan 

instalasi file Plug‐In, biasanya secara default lokasi tujuan instalasi sudah benar. Kemudian 

tekan Next untuk melanjutkan. 

5. Lalu akan tampil kotak dialog Ready to Onstall the Program, apabila kita telah siap untuk 

menginstal program tekan Install. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 11.79 Kotak dialog Customer Information 
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Gambar 11.82 Proses instalasi SteadyMove 

 

 

6. Maka proses instalasi akan dimulai. 
 

7. Jika proses instalasi telah selesai maka akan tampil kotak dialog InstallShield Wizard 

Completed. Kemudian tekan Finish untuk mengakhiri. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 11.81 Kotak dialog Ready to Install the Program 
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Gambar 11.84 Letak efek video SteadyMove dalam Tab Effects 

 

 
 

Aplikasi Efek 

Berikut ini langkah-langkah latihan menggunakan efek video SteadyMove : 
 

1. Susun sebuah clip yang memiliki gambar tidak stabil ke dalam Timeline Window. 

 

2. Kemudian buka Tab Effects yang ada dalam Project Window. 

 

3. Expand pilihan Video Effects. 

 

4. Expand folder 2d3. 

 

5. Pilih efek SteadyMove kemudian drag dan drop ke dalam clip pada Timeline Window. 
 

6. Kemudian buka Tab Effect Controls untuk melakukan pengaturan efek SteadyMove. 

Gambar 11.83 Kotak dialog tanda proses instalasi telah selesai 
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7. Terdapat dua parameter yaitu Smoothing dan Max Correction. Smoothing berfungsi mengatur 

kehalusan gerakan kamera (defaultnya 80%). Sedangkan Max Correction berfungsi untuk 

mengontrol zoom dan cropping dari clip yang dihaluskan gerakannya (defaultnya 7%). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 11.85 Property efek video SteadyMove dalam Tab Effects Control 
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BAB 12 

 MENGEKSPOR MOVIE 
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Gambar 12.1 Tampilan proyek video yang siap diekspor 

Clip-clip yang telah kita susun dan edit dalam Timeline Window selanjutnya dapat 

diekspor menjadi berbagai format akhir. 

Adobe Premiere Pro mendukung banyak format media sebagai hasil akhir proses ekspor. 

Untuk format video Adobe Premiere mendukung format Microsoft AVI dan DV AVI, 

Animated GIF, MPEG, RealMedia, QuickTime, serta Windows Media. 

Untuk format audio Adobe Premiere Pro mendukung format Microsoft AVI dan DV 

AVI, MPEG, RealMedia, QuickTime, serta Windows Audio Waveform. Untuk format 

still-image Adobe Premiere Pro mendukung format Filmstrip, FLC/FLI, Targa, TIFF, dan 

Windows Bitmap. 

Sedangkan untuk format sequence Adobe Premiere Pro mendukung format GIF 

sequence, Targa sequence, TIFF sequence, dan Windows Bitmap sequence. 

 

Mulai Mengekspor Movie 

Untuk mengekspor susunan clip dalam Timeline Window menjadi format akhir caranya : 
 

1. Tentukan terlebih dahulu work area mana yang akan diekspor. Kita dapat menentukan batas 

work area dengan menggeser ujung kiri dan ujung kanan dari Work Area Bar dalam Timeline 

Window. 
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Gambar 12.2 Pengaturan work area dalam Timeline Window 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Gambar 12.3 Kotak dialog Export Movie 

 

 

2. Lalu pada menu pilih File > Export > Movie. 

 

3. Maka akan tampil kotak dialog Export Movie. 

 

4. Kemudian ketikkan nama file hasil akhir. 
 

5. Kemudian tekan tombol Settings. Maka kotak dialog Export Movie Settings akan tampil. 
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Gambar 12.5 Proses ekspor/render 

 

 

6. Lakukan pengaturan format media ekspor lewat pilihan File Type lalu pilih format media 

sesuai dengan yang diinginkan. 

7. Lalu tekan OK. 

 

8. Kemudian pada kotak dialog Export Movie tekan tombol Save. 

 

9. Maka Adobe Premiere Pro akan mulai mengekspor. 
 

10. Selain mengekspor ke dalam bentuk/format movie Adobe Premiere Pro dapat melakukan 

ekspor ke dalam bentuk Frame dan Audio. Untuk mengekspor ke dalam bentuk frame (still‐ 

image) pada menu pilih File > Export > Frame. Sedangkan untuk mengekspor ke dalam bentuk 

audio pada menu pilih File > Export > Audio. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12.4 Kotak dialog Export Movie Settings 
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Gambar 12.6 Adobe Media Encoder 

Menggunakan Adobe Media Encoder 

Untuk mengekspor movie ke dalam bentuk MPEG-1 (VCD) dan MPEG-2 (DVD) atau 

dalam format video streaming Adobe Premiere Pro menyediakan fasilitas encoding 

terintegrasi dengan nama Adobe Media Encoder. Untuk menampilkan Adobe Media 

Encoder caranya pada menu pilih File > Export > Adobe Media Encoder. Maka akan 

tampil kotak dialog Transcode Settings. Kemudian pilih format ekspor dalam pilihan 

Format, kemudian atur juga parameter Preset yang terletak dibawahnya. Untuk memulai 

proses encoding tekan tombol OK. 

 

Merekam Video Pada Tape 

Untuk melakukan perekaman movie ke dalam tape atau camcorder, terlebih dahulu 

hubungkan tape/camcorder dengan komputer melalui interface FireWire atau IEEE 1394. 

Kemudian setelah terhubung dan komputer mengenali perangkat perekaman/tape, dalam 

menu Adobe Premiere Pro pilih File > Export > Export to Tape. Maka akan tampil kotak 

dialog Export to Tape. Untuk melakukan proses perekaman tekan tombol Record. 
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Gambar 12.8 Logo Canopus ProCoder 

 

 
 

Peranan Canopus ProCoder Untuk Encoding Video 

ProCoder merupakan software encoding profesional buatan Canopus sebuah perusahaan 

yang concern dalam bidang pembuatan software pengolahan video dan broadcasting. 

ProCoder menawarkan banyak fitur konversi, kecepatan render serta kualitas render. Fitu-

fitur tersebut antara lain adanya fasilitas konversi aspect ratio, frame rate dan konversi 

standar video (PAL dan NTSC), selain itu ProCoder juga mendukung banya format 

media sebagai hasil encoding diantaranya MPEG-1 (VCD), MPEG-2(DVD), Windows 

Media Format, QuickTime, dan Real Video. Dengan ProCoder kita dapat melakukan 

encoding dalam waktu yang lebih singkat dengan kualitas hasil yang tinggi. 

Gunakan ProCoder untuk meng-encode movie hasil render /eksporAdobe Premiere Pro 

(dalam format Microsoft DV AVI) untuk menghasilkan format MPEG-1 (VCD), caranya 

: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12.7 Kotak dialog Export to Tape 
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Gambar 12.9 Tampilan program Canopus ProCoder 

1. Pada Start Menu pilih Start > All Programs > Canopus ProCoder > Canopus ProCoder, untuk 

menjalankan Canopus ProCoder. 

2. Setelah program Canopus ProCoder tampil, maka secara default area kerja yang tampil adalah 

Source, kemudian klik tombol Add untuk menunjukkan lokasi video target (sumber video 

yang akan diencoding). 

 

3. Maka akan tampil kotak dialog Open, lalu pilih video sumber yang akan diencode (dalam 

format Microsoft DV AVI). 

4. Kemudian tekan Open. 

 

 
 

Gambar 12.10 Tombol Add 
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Gambar 12.12 Data-data video sumber dalam area kerja Source 

 

 

 
Gambar 12.13 Tombol Target 

 

 

5. Maka akan tampil data‐data dari video sumber dalam area kerja Source di sebelah kanan. 
 

6. Kemudian klik tombol Target untuk membuka area kerja Target. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12.11 Kotak dialog Open 
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Gambar 12.15 Kotak dialog Add Target 

 

 

7. Kemudian tekan tombol Add yang ada dalam area kerja target. 

 

8. Maka akan tampil kotak dialog Add Target, kemudian pilih format encoding yang 

dikehendaki. 

9. Lalu tekan OK. 

 

10. Maka data‐data format video target akan tampil dalam area kerja Target. 

 

11. Kemudian atur lokasi penyimpanan hasil encoding dalam pilihan Destination > Path dalam 

Target Parameters. 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 12.14 Area kerja Target 
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Gambar 12.17 Tombol Convert 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12.18 Area kerja Convert 

 

 

Gambar 12.19 Tombol Convert 

 

 

12. Kemudian tekan tombol Convert. 
 

13. Maka akan tampil area kerja Convert. 
 

14. Setelah itu tekan tombol Convert untuk melakukan proses encoding. 

 

15. Maka akan dihasilkan sebuah file dalam lokasi yang telah ditentukan tadi. 
 

 

 

 

 

 

 
Gambar 12.16 Pengaturan lokasi penyimpanan hasil encoding 
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Gambar 12.20 Kotak dialog Nero Wizard 

Peranan Ahead Nero Burning ROM Untuk Membuat 

VCD 

Setelah mengencode project menjadi format MPEG menggunakan Adobe Media Encoder 

atau Canopus ProCoder, maka selanjutnya file MPEG tersebut akan dikemas ke dalam 

CD menjadi format VCD menggunakan software Ahead Nero Burning Rom. Berikut ini 

langkah-langkahnya : 

1. Setelah di‐install, jalankan Ahead Nero Burning ROM lewat Start Menu. Caranya : pilih Start > 

All Programs > Ahead Nero > Nero Burning Rom. 

2. Maka akan tampil kotak dialog Nero Wizard. 
 

3. Apabila pilihan CD telah terpilih, maka klik Next untuk melanjutkan. 
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Gambar 12.22 Kotak Dialog Nero Wizard (Compile a New CD) 

 

 

4. Masih dalam kotak dialog Nero Wizard, pilihlah Compile a new CD, kemudian klik Next. 
 

5. Pilih Other CD formats. Selanjutnya klik Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12.21 Kotak dialog Nero Wizard 
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Gambar 12.24  Nero Wizard (Video CD) 

 

 

6. Kemudian pilihlah Video CD. Setelah itu klik Next. 
 

7. Lalu klik Finish. Maka berikutnya akan tampil area kerja Nero – Burning Rom. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12.23 Kotak dialog Nero Wizard (Other CD Format) 
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Gambar 12.26 Hasil drag and drop 

 

 

8. Pada area kerja tersebut dibagi menjadi dua, sebelah kiri merupakan browser VCD yang akan 

dibuat, sedangkan di sebelah kanan merupakan file Browser dari komputer. 

9. Selanjutnya pindahkan file *.mpg hasil render tadi yang berada pada browser di sebelah kanan 

ke dalam browser di sebelah kiri dengan cara drag and drop. 

10. Untuk membakar CD pilih File > Write CD. Maka akan tampil kotak dialog Nero Wizard 

(Burn CD). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 12.25 Area kerja Nero Burning Rom 
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Gambar 12.28  Kotak Dialog Write CD 

 

 

11. Pilih Write speed, kemudian klik Burn. 

 

12. Maka akan tampil kotak dialog Write CD. Selanjutnya tunggu sampai proses selesai. 
 

13. Apabila proses pembakaran telah selesai, maka akan tampil kotak dialog yang 

mengkonfirmasikan bahwa proses tersebut telah selesai. Klik OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12.27 Kotak Dialog Nero Wizard (Burn CD) 
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14. Maka akan dihasilkan VCD yang dapat diputar pada player VCD. 

 

 

 

 

 

 
Gambar 12.29 Proses burning CD telah selesai 
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